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Welcome 
It might be easier to say what this guide isn’t, rather than what it is. It isn’t an in 

depth look at every single function available within the WordPress dashboard. 

Nor is it a guide to help you develop or modify WordPress themes. My aim is to 

create a simple WordPress guide that will help you to get an understanding of 

how you use the various features within the WordPress Dashboard to keep your 

site or blog updated. 

If you’re looking for more in-depth knowledge, there are heaps of articles in the 

WordPress Codex that go into more detail. This is great if you want to get really 

involved in developing your own WordPress theme or modifying your site with 

plugins, but it can be a bit daunting for those users who just want a simple guide 

to using the Content Management side of WordPress or just need to update their 

site pages every so often. 

http://codex.wordpress.org/Main_Page


 

Introduction 
WordPress is an Open Source software system used by millions of people around 

the world to create beautiful websites and blogs. It is completely customisable by 

the use of themes and plugins. 

“WordPress is web software you can use to create a beautiful 

website or blog. We like to say that WordPress is both free 

and priceless at the same time.” 

Themes can be easily downloaded from the official WordPress site or from 

hundreds of other places around the web. The same goes with plugins, which are 

used to extend the functionality of your WordPress site. 

As well as being a fantastic blogging and content management system, one of the 

huge benefits is the wealth of information out there. There’s a great community of 

people behind the design & development of the WordPress system itself. People 

from all over the world contribute their time, knowledge and skill to keeping 

WordPress updated and secure. 

There’s also a huge number of designers, developers & bloggers who share their 

knowledge through blog posts, tutorials, reviews, videos and the creation of 

thousands of themes & plugins. 

WordPress powers a staggering amount of websites. In fact, it powers over 29% of 

the whole web! Everything from personal blogs to large corporate websites. The 

following are just a very few examples of the millions of diverse sites powered by 

WordPress... 

 

Women’s National Basketball Association (WNBA) – http://www.wnba.com 

The Women’s National Basketball Association (WNBA) was founded in 1996, as 

the women’s counterpart to the National Basketball Association (NBA). 

BBC America – http://www.bbcamerica.com 

Presenting Britain’s best shows and groundbreaking American originals, BBC 

America is home to brilliant television from both sides of the pond. 

The National Puerto Rican Day Parade – http://www.nprdpinc.org 

The National Puerto Rican Day Parade in NYC is the largest parade in the country. 

http://en.wikipedia.org/wiki/Open_source
http://wordpress.org/themes/
http://wordpress.org/plugins/
http://www.wnba.com/
http://www.bbcamerica.com/
http://www.nprdpinc.org/


 

The National Puerto Rican Day celebrates and honours the leaders, educators, 

artists, and celebrities that have left a cultural footprint on this nation. 

Felicia Day – http://feliciaday.com 

Felicia Day is a professional actress who has appeared in numerous television 

shows including, Buffy the Vampire Slayer, Supernatural and Eureka. Felicia is best 

known for her work in the web video world. She costarred in Joss Whedon’s 

Emmy Award–winning Internet musical, Dr. Horrible’s Sing-Along Blog. She also 

created and starred in the hit web series The Guild. 

The Official Star Wars Blog – http://www.starwars.com/news 

Star Wars is an American epic space opera franchise conceived by George Lucas. 

The first film in the franchise was originally released on May 25, 1977, by 20th 

Century Fox, and became a worldwide pop culture phenomenon. Star Wars is one 

of the most popular movie series of all time and the series’ official blog is powered 

by WordPress. 

thisisFINLAND – http://finland.fi 

thisisFINLAND forms an attractive window on Finland for everyone interested in 

our country, its culture and its people. Produced by the Ministry for Foreign 

Affairs of Finland and published by the Finland Promotion Board, thisisFINLAND 

was originally established in 1995 as Virtual Finland. 

Ladies Learning Code – http://ladieslearningcode.com 

A new Toronto-based collective of women working to empower everyone to feel 

comfortable learning basic, beginner-friendly technical skills in a social, 

collaborative way. 

http://feliciaday.com/
http://www.starwars.com/news
http://finland.fi/
http://ladieslearningcode.com/


 

Login 
Before you can make any changes to your site, you will need to log in. The login 

for your site is typically found at the following URL - http://your-wordpress-

site.com/wp-admin. Obviously, replace your-wordpress-site.com with your actual 

domain name. 

 

There are exceptions to this of course. For instance, your WordPress setup maybe 

installed in a subdirectory. For most standard setups though, you’ll find the above 

URL should work. 

You can login to your Dashboard using either your Username or your email 

address associated with your account. 

http://en.wikipedia.org/wiki/Url


 

Dashboard 
Once you’ve logged in, the WordPress Dashboard appears. This is your main 

administration homepage. At the very top of your Dashboard (and across every 

page) you will see the name of your site in the header area. In the example 

screenshot below (and throughout this documentation) the site name is Your 

WordPress Site. This is also hyperlinked to your site's homepage. You will also see 

the name of the person who is currently logged in (e.g. Joe Blogg). Move your 

cursor over your name to reveal the Log Out link as well as a link to edit your 

Profile. 

When new or updated features are introduced into WordPress, you’ll be shown a 

New Feature Pointer. This is simply to bring to your attention some feature within 

the Dashboard that’s been added or updated. In the following Dashboard image, 

the New Feature Pointer is highlighting the updated Toolbar. Click Dismiss to hide 

the pointer. 

 

 

On most pages, just below your Username there are a couple of small inverted 

tabs. One called Screen Options and another called Help. Clicking either of these 

links will cause a panel to slide down from the top of the page. The Help link, not 

surprisingly, displays some help information. The Screen Options link will display 

various options that allow you to configure what is displayed on the current page. 



 

The details in this panel change depending on what page you’re currently 

viewing. As an example, on your main Dashboard page the Screen Options allow 

you to set which panels you’d like displayed on the page. 

Dashboard Menu Options 
Down the left-hand side of the Dashboard and on every page you will see your 

main navigation menu. This is where you’ll find all the options to update and 

configure your site. 

Hovering your cursor over each of the main menu options will display a ‘fly-out’ 

menu with the various choices for that particular menu option. Once you click 

each of the main menu options, that particular menu will expand to show all the 

available options within that section (if there are any). 

 

The main menu options and their usage are: 

Dashboard 
This will display your main Dashboard ‘homepage’. In the top left of your 

Dashboard you’ll see some brief stats on the number of Posts, Pages and 

Comments. If you have the Akismet anti-spam plugin activated, you’ll also see the 

number of Spam Comments or comments awaiting moderation. 

Posts 
This is where you can create a new Blog Post. You can also update your Categories 

and Post Tags. 

http://akismet.com/
http://en.wikipedia.org/wiki/Spam_(electronic)


 

Media 
This is where all your uploaded images, documents or files are stored. You can 

browse through your Media library, as well as edit and update the files. 

Pages 
This is where you create and maintain all your Pages. 

Comments 
You can manage all your Comments within this section, including replying to 

comments or marking them as spam. 

Appearance 
This menu is where you control how your site looks. You can choose a new 

Theme, manage your site Widgets or Menus and even edit your site theme files. 

Plugins 
Plugins extend and expand the functionality of WordPress. You can add or delete 

plugins within here as well as activate or deactivate them. 

Users 
This screen lists all the existing users for your site. Depending on your Role, you 

can also add new users as well as manage their Roles. 

Tools 
This section gives you access to various convenient tools. You can also import data 

to your WordPress site or export all your WordPress data to a file. 

Settings 
This is where most of your site is configured. Among other things, it allows you to 

configure your site name and URL , where your Posts appear, whether people can 

leave Post Comments or not and numerous other settings. Most times, once your 

site is setup, there's no need to change any of the settings within this section. 

At the bottom of the menu you'll see a link called Collapse menu. Clicking this will 

hide the menu and simply display their icons instead. Click the small arrow icon 

again to expand the menu. 

Occasionally when you install a plugin, they will have their own configuration or 

setup pages. The location of these will be entirely dependent on the individual 



 

plugin but most times these pages will either appear within the Tools section, the 

Settings section or in a completely new menu section at the bottom of the menu. 

Toolbar 
The WordPress Toolbar is a way of easily accessing some of the most common 

WordPress features. When you are logged into your WordPress dashboard and 

you visit your website, you will see the Toolbar running across the top of your 

site. This bar only appears if you are currently logged into your WordPress site, 

which means that it won’t be visible to your everyday site visitors. If you are not 

logged in, the Toolbar won’t be displayed. 

 

The Toolbar allows you to quickly access the following commonly used features.  

• Visit the WordPress.org website, Codex or Support forums 

• Display your site Dashboard and other commonly used menu options that 

allow you to update your site Themes, Widgets and Menus 

• Visit the Customizer to update various site settings and depending on your 

theme, update your Background and Header images 

• View or Edit your blog comments 



 

• Add a new Post, Media, Page or User 

• Perform a site Search 

• View or Edit your Profile and logout from the WordPress Dashboard 

Hiding the Toolbar 
You can stop the Toolbar from displaying by modifying the preferences associated 

with your Profile. Simply click on the Users link in the left-hand navigation to 

display the list of Users. From this list of Users, click your user name or click on 

the Edit link that appears beneath the user name when hovering your cursor over 

each row. Alternatively, click on the Your Profile link underneath the Users menu 

option in the left-hand navigation or within the fly-out menu. 

 

When editing your Profile there is a Toolbar option as shown in the screen above. 

• Show Toolbar when viewing site – Checking this box will display the 

Toolbar at the very top of your website (only for the person who is currently 

logged in) 



 

Posts versus Pages 
WordPress is built around two basic concepts. Posts and Pages. Posts are typically 

blog entries. A series of articles, listed (usually) reverse-chronologically. Pages are 

used for more static content (i.e. content that doesn’t change or changes 

infrequently). An ‘About us’ page is an example of a Page on a typical website. In 

most cases you’ll find that the content in the ‘About us’ page doesn’t change all 

that frequently. 

Now, you might be thinking, “but I don’t need a blog”. This might be true, but you 

can also use the blog concept if you have a site where you need to display your 

‘latest news’ or even just company updates. Basically, any information that gets 

updated on a semi-regular basis can benefit from the ‘blog’ functionality. Whether 

that’s a traditional blog, your company’s ‘latest news’ or even just your own 

personal updates. 

Posts 
After clicking on the Posts menu option you'll be shown a list of Posts that your 

site contains. Among the information displayed is the Post title, the Author, 

Categories, Tags, No. of Comments and either the Date Published, Date Scheduled 

or the Date the Post was Last Modified. The Posts screen will look similar to the 

screen below. 



 

 

At the top of the page you can view how many Posts in total you have in your site, 

how many have been published by yourself or Published, Scheduled, Sticky, 

Pending, in Draft or in the Trash. 

When hovering your cursor over each row, a few links will appear beneath the 

Post title.  

• Edit – Will allow you to edit your Post. This is the same as clicking on the Post 

title 

• Quick Edit – Allows you to edit basic Post information such as Title, Slug, 

Date plus a few other options 

• Trash – Will send the Post to the Trash. Once the Trash is emptied, the page is 

deleted 

• View – Displays the Post. If the Post hasn’t been published yet, this will say 

Preview 

Next to each Post title is a checkbox. This allows you to perform an action on 

multiple items at once. You simply check the Posts that you would like to affect 



 

and then from the Bulk Actions dropdown select either the Edit option or the 

Move to Trash option and then click the Apply button. The Edit option will allow 

you to edit the Categories, Tags, Author, whether to allow Comments and Pings or 

not, the Status and whether or not the Posts are ‘Sticky’. The Move to Trash option 

will move the selected items to the Trash. 

You can also filter the pages that are displayed using the dropdown lists and the 

Filter button. 

Clicking the Screen Options button at the top-right of the screen allows you to 

change how the Posts list is displayed. Click the List View option to display the 

posts in the traditional List View or click the Excerpt View option to display a short 

excerpt from the Post underneath the Post title. You can also hide various 

columns from view if you don’t want to see them. Clicking the Apply button will 

save your changes. 

Pages 
After clicking on the Pages menu option you'll be shown a list of Pages that your 

site contains. Among the information displayed is the Page title, the Author, No. of 

Comments and either the Date Published or the Date the Page was Last Modified. 

The Pages screen will look similar to screen below. 



 

 

At the top of the page you can view how many Pages in total you have in your site, 

how many have been published by yourself or how many are Published or in 

Draft. 

When hovering your cursor over each row, a few links will appear beneath the 

Page title.  

• Edit – Will allow you to edit your Page. This is the same as clicking on the 

Page title 

• Quick Edit – Allows you to edit basic Page information such as Title, Slug, 

Date plus a few other options 

• Trash – Will send the Page to the Trash. Once the Trash is emptied, the page 

is deleted 

• View – Displays the Page. If the Page hasn’t been published yet, this will say 

Preview 

Next to each Page title is a checkbox. This allows you to perform an action on 

multiple items at once. You simply check the Pages that you would like to affect 



 

and then from the Bulk Actions dropdown select either the Edit option or the 

Move to Trash option and then click the Apply button. The Edit option will allow 

you to edit the Author, Parent, Template, whether to allow Comments or not and 

the Status of each of the checked items. The Move to Trash option will move the 

selected items to the Trash. 

You can also filter the pages that are displayed using the dropdown list and the 

Filter button. 



 

Adding your Site Content 
Adding content to your site is an easy process no matter whether you’re creating a 

Post or a Page. The procedure for both is almost identical. Apart from how they 

display on your site, which was described earlier, the other main difference is 

that Posts allow you to associate Categories and Tags whereas Pages don’t. What’s 

the difference between categories and tags? Normally, Tags are ad-hoc keywords 

that identify important information in your Post (names, subjects, etc) that may or 

may not recur in other Posts, while Categories are pre-determined sections. If you 

think of your site like a book, the Categories are like the Table of Contents and the 

Tags are like the terms in the index. 

Adding a New Page 
To add a new Page, hover your cursor over the Pages menu option in the left-hand 

navigation menu and in the fly-out menu, click the Add New link. Alternatively, 

click the Pages menu option and then click the Add New link underneath, or the 

Add New button at the top of the page. You will be presented with a page similar 

to the image below. 

http://codex.wordpress.org/Posts_Categories_SubPanel
http://codex.wordpress.org/Posts_Post_Tags_SubPanel


 

 

Adding a New Post 
To add a new Post, hover over the Posts menu option in the left-hand navigation 

menu and in the fly-out menu, click the Add New link. Alternatively, click the 

Posts menu option and then click the Add New link underneath, or the Add New 

button at the top of the page. You will be presented with a page similar to the 

image below. 



 

 

Adding Content with the Visual Editor 
The editor used to enter content into your Page or Post is very easy to use. It’s 

much like using a regular word processor, with toolbar buttons that allow you to 



 

Bold ( ) or Italicize ( ) text or enter in Headings ( ) or 

bullet points ( ). You can even use most of the basic keyboard shortcuts 

used in other text editors. For example: Shift+Enter inserts a line break, 

Ctrl+C/Cmd+C = copy, Ctrl+X/Cmd+X = cut, Ctrl+Z/Cmd+Z = undo, Ctrl+Y/Cmd+Y = 

redo, Ctrl+A/Cmd+A = select all, etc. (use the Ctrl key on a PC or the Command key 

on a Mac). 

When adding content to your page, the Visual Editor expands to fit your content, 

rather than simply scrolling. On top of that, no matter how tall the Visual Editor 

becomes, the toolbar buttons will be available at all times by sticking to the top of 

the page. 

By making use of special keyboard shortcuts, adding content is now even easier. 

When you want to add different size headings to your content, rather than having 

to select the heading size from the toolbar dropdown you can now start a line 

with two or more hashtags (#) and once you hit Enter to go to the next line, the 

Visual Editor will automatically convert your text to the appropriate heading. Like 

headings, you can also use * or - to create an unordered list, using 1. will start an 

ordered list, and > will create a blockquote. 

The complete list of keyboard shortcuts available are as follows; 

• * – Start an unordered list 

• - – Start an unordered list 

• 1. – Start an ordered list 

• 1) – Start an unordered list 

• ## – H2 

• ### – H3 

• #### – H4 

• ##### – H5 

• ###### – H6 

• > – Add a blockquote 



 

• --- – Add a horizontal line 

• `..` – Convert text into code block (replace .. with your text) 

At the top of the editor there are two tabs, Visual and Text ( ). 

These switch the editor view between the Visual Editor and the Text editor. The 

Text view will enable you to view the HTML code that makes up your content. For 

the more experienced users this can be helpful at times but for those not familiar 

with HTML tags, it’s not recommended. 

When creating a new Page or Post, the first thing to do is enter in your title in the 

top entry field where it says Enter title here. After moving the cursor down to the 

editor a new Permalink is created for your page. Permalinks are the permanent 

URL’s to your individual Posts, Pages, Categories etc.. Though not usually 

necessary, you can manually edit your permalink by clicking on the actual 

permalink (the part after the domain name with the yellow background) or by 

clicking the Edit button next to it. Once you’ve modified it, click Ok to save or 

Cancel to cancel your changes. 

At the top of the editor where your content is written, there are numerous 

formatting buttons. Clicking the Toolbar Toggle button ( ) will show or hide a 

second line of formatting buttons which gives you extra functionality. The editor 

buttons perform the following functions: 

 
Add Media – Used to upload and insert media such as images, 
audio, video or documents  

 
Style – Used to format the Page text based on the styles used by 
the current Theme 

 
Bold – Bold text 

 
Italic – Italicise text 

 
Bulleted List – Create an unordered (bullet point) list 

http://codex.wordpress.org/Using_Permalinks


 

 
Numbered List – Create an Ordered (numbered) list 

 
Blockquote – Used as a way of showing a quote. How this 
looks will be entirely dependent on the Theme that your site is 
currently using 

 
Align Left – Align text to the left 

 
Align Center – Align text in the center of the page 

 
Align Right – Align text to the right 

 
Insert/edit link – Used to create an html link to another page 
or website. If no text is selected first, the URL that you enter 
will also be used for the link text 

 
Insert Read More tag – Inserts the More tag into your Page. 
Most blogs only display a small excerpt of a Post and you’re 
required to click the Post title or a ‘Read more...’ link to 
continue reading the rest of the article. When you insert a 
‘More’ tag into your Post, everything prior to the tag is 
considered as this excerpt. Most times you’d only use this 
button when you’re creating a blog Post, rather than a Page 

 
Toolbar Toggle – Used to show or hide the second row of 
formatting buttons on the editor toolbar 

 
Distraction Free Writing – Clicking this button will enlarge 
the editor so that it fills the browser window. Clicking the Exit 
fullscreen link at the top of the screen will reduce it back to its 
original size 

 
Strikethrough – Add a strikethrough to your text 

 
Horizontal Line – Inserts a horizontal line into your page 



 

 
Text color – Use to change the color of text 

 
Paste as text – Copying and pasting text from other sites or 
word processors sometimes leaves the text formatted 
differently to what you were expecting. The reason for this is 
that quite often the html tags or codes that formatted the 
original text are pasted along with the text itself. To avoid this, 
Paste as Text will strip all these formatting and html tags. The 
Paste as Text option acts like a toggle, staying on until you turn 
it off by clicking the button again or until you save your page 
content 

 
Clear formatting – Use this to remove all the formatting (e.g. 
Bold, Underline, text color etc..) from the highlighted text 

 
Special character – Used to insert special characters not easily 
accessible via the keyboard (e.g. ¼, ½, ¾, ©, € , ö etc..) 

 
Decrease indent – Removes one level of indenting 

 
Increase indent – Indents text by one level 

 
Undo – Undo your last action 

 
Redo – Redo your last action 

 
Keyboard shortcuts – Displays information about the 
WordPress Visual Editor along with keyboard shortcuts 

 
Visual/Text – Switches the editor view between the Visual 
Editor and the Text editor. The Text view will enable you to 
view the HTML code that makes up your content. For the more 
experienced users this can be helpful at times but for those not 
familiar with HTML tags, it’s not recommended 

 



 

Switching to the Text Editor 

At the top of the editor there are two tabs, Visual and Text ( ). 

These switch the editor view between the Visual Editor and the Text editor. The 

Text view will enable you to view the HTML code that makes up your content. For 

the more experienced users this can be helpful at times but for those not familiar 

with HTML tags, it’s not recommended. 

The Text editor is much like the Visual Editor, only not as intuitive. The numerous 

formatting buttons provide you with basic HTML formatting capabilities when 

editing your Page or Post content. 

 

The buttons work in two ways. Clicking a button without highlighting any text 

first, will simply insert the opening HTML tag relevant for that button. As an 

example, clicking the Bold button will insert the <strong> HTML tag into your text. 

Clicking the Bold button again will close the tag by inserting the closing </strong> 

tag. If you highlight some text prior to clicking a button, both the opening and 

closing tags will be inserted around that highlighted text. For example, 

highlighting the text, ‘bold text’, prior to clicking the Bold button will insert 

‘<strong>bold text</strong>’. 

The following editor buttons are available whilst in the Text editor: 

 
Bold – Bold text 



 

 
Italic – Italicise text 

 
Link – Used to insert a website link. When the button is clicked 
a pop-up window will appear where you type in the URL that 
you would like to link to 

 
Blockquote – Used as a way of showing a quote. How this looks 
will be entirely dependent on the Theme that your site is 
currently using 

 
Delete – Used as a way of showing deleted text. How this looks 
will be dependent on the Theme but is usually done by 
showing the text with a strikethrough 

 
Insert – Used as a way of showing inserted text. How this looks 
will be dependent on the Theme but is usually done by 
showing the text with an underline 

 
Image – Used to insert an image into the text. When the button 
is clicked a pop-up window will appear where you type in the 
URL of the image that you would like inserted 

 
Unordered List – Used to insert an unordered (bullet point) list 

 
Ordered List – Used to insert an ordered (numbered) list 

 
List Item – Used to insert a list item into your ordered or un-
ordered list 

 
Code –Used for indicating a piece of code 



 

 
More – Inserts the More tag into your Page. Most blogs only 
display a small excerpt of a Post and you’re required to click 
the Post title or a ‘Read more...’ link to continue reading the 
rest of the article. When you insert a ‘More’ tag into your Post, 
everything prior to the tag is considered as this excerpt. Most 
times you’d only use this button when you’re creating a blog 
Post, rather than a Page 

 
Close Tags – Used to close open tags. If for example, you 
clicked both the Bold and Italic buttons to insert their opening 
tags, clicking the Close tags button will insert both of the 
matching closing tags, in the correct order 

 
Distraction Free Writing – Clicking this button will enlarge 
the editor so that it fills the browser window. Clicking the Exit 
fullscreen link at the top of the screen will reduce it back to its 
original size 

 

Changing your Post Format 
A Post Format is meta information that can be used within a Theme to style or 

customise the presentation of a Post. The Post Formats feature provides a 

standardised list of formats that are available to all themes that support the 

feature. There is no requirement for Themes to support every format on the list 

and new formats cannot be introduced by themes or even plugins. If your Theme 

supports Post Formats you can choose how each Post looks by selecting a Post 

Format from a list of radio buttons, similar to the following screen. If your Theme 

doesn’t support Post Formats then the Format panel won’t be displayed. 



 

 

While the actual post content entry won't change, the theme can use the selected 

Format to display the post differently. How content is displayed is entirely up to 

the Theme, but the following list of available Post Formats provides some general 

WordPress guidelines as to how they might be styled. 

• Standard – This is the standard/default blog post format. 

• Aside – Typically styled without a title. Similar to a Facebook note update 

• Audio – An audio file, such as a Podcast 

• Chat – A chat transcript 

• Gallery – A gallery of images. Post will likely contain a gallery shortcode and 

will have image attachments 

• Image – A single image 

• Link – A link to another site 

• Quote – A quotation, most likely contained within a blockquote 

• Status – A short status update, similar to a Twitter status update 

• Video – A single video 

http://codex.wordpress.org/Shortcode


 

Reviewing Past Revisions 
When you’re editing your Post or Page, the number of revisions for that particular 

Post or Page is shown in the Publish Panel, if you have any. 

Click the Browse link next to Revisions: in the Publish panel to browse through the 

various revisions for the current Post or Page. 

 

Use the slider at the top of the page or click the Previous and Next buttons to 

navigate through your various Post or Page revisions. 

Content that has been deleted will be shaded red and content that has been added 

will be shaded green. If there is content that is shaded dark red and/or dark green, 

it’s highlighting specific content that was removed or added. If the paragraph or 

line is simply light red and/or light green, then the whole paragraph or line was 

affected by the change. 

You can also compare two different revisions by clicking the Compare any two 

revisions checkbox at the top of the page. 

If you’d like to restore a previous revision, click the Restore This Revision button. 



 

 



 

Adding Images and Other Media 
Adding images and other media files such as videos, documents or PDFs is 

extremely easy within WordPress. All your images and files are stored in the 

Media Library. Once they’re uploaded into the Media Library, it’s a very simple 

matter to insert them into your Page or Post content. In the case of files such as 

Word Documents or PDFs, if necessary, it’s a simple process to create links to 

those files so that people can then download them. 

Inserting an Image 
Using the WordPress media manager, it’s extremely simple to insert, align and 

link your individual images and image galleries. 

To insert an image into your Page/Post, click the Add Media button (

) and then simply drag your image(s) from wherever they are on 

your computer, into the browser window. Your file(s) will be automatically 

uploaded.  

Alternatively, click the Select Files button and then select the file(s) that you’d like 

to upload, using the dialog window that is displayed. 

It’s also possible to simply drag your image straight into the Visual Editor, rather 

than clicking the Add Media button. 



 

 

No matter whether you’ve clicked the Add Media button or simply dragged and 

dropped your image into the Visual Editor, once your image is uploaded, your 

Media Library is displayed, which contains all your previously uploaded images. 

The image(s) that you’ve just uploaded will be automatically ‘selected’ for easy 

insertion into your Page or Post. Selected images are shown with a ‘tick’ icon in 

the top right corner of the image. 

After uploading your image(s), you can then select other previously uploaded 

images by holding down the Ctrl key (Cmd key on Macs) and simply clicking on 

them. To deselect an image, click the ‘tick’ in the top right corner of the image. 

At the bottom of the window you will see a count of the number of images 

currently selected. 

There are several options within this Insert Media window to help make it easier 

to add images into your Page or Post. 



 

By default, all previously uploaded images are shown, starting with the most 

recent uploads. If you’d like to narrow this list down, at the top of the window is a 

dropdown list that allows you to filter your displayed images by All media items, 

items Uploaded to this post/page, or Images, Audio files, Video files or Unattached 

files. You can also filter your media files by selecting a date, or alternatively, there 

is also a Search field that allows you to search for specific images. 

The properties of the currently highlighted image (i.e. The image with the blue 

border) will be shown on the right-hand side of the Insert Media window. These 

properties include the filename, the date the file was uploaded and the image size. 

It’s at this point you can also change the image Title, Caption, Alt Text and 

Description for each image, as well as the Alignment, Link and the Size at which 

the image is inserted. 

• Title – is displayed as a tooltip when the mouse cursor hovers over the image 

in the browser 

• Caption – is displayed underneath the image as a short description. How this 

displays will be dependent on the WordPress theme in use at the time. You 

can also include basic HTML in your captions 

• Alt Text – is displayed when the browser can’t render the image. It’s also 

used by screen readers for visually impaired users so it’s important to fill out 

this field with a description of the image. To a small degree, it also plays a 

part in your website Search Engine Optimisation (SEO). Since search engines 

can’t ‘read’ images they rely on the Alt Text 

• Description – is usually displayed on the attachment page for the media, 

however this is entirely up to the theme that is currently in use 

http://en.wikipedia.org/wiki/Alternate_text


 

 

For each image, you can select how you would like the image aligned, either Left, 

Center or Right aligned, using the Alignment dropdown list. You can also select 

None for no alignment which will mean the image will display using the default 

alignment setting for your Theme. 

You can also change what your inserted image(s) will link to using the Link To 

dropdown list. You have the choice of linking to the image’s attachment page by 

selecting Attachment Page, or you can link to the full size image by selecting Media 

File. You can also link to any URL by selecting Custom URL. When you do this, a 

new field will appear that allows you to enter in the custom URL. You can also 

choose not to link to anything by selecting None. 

When your image(s) are uploaded, WordPress will also create several copies of 

your file at various sizes. You can choose which one you’d like to insert into your 

Page or Post using the Size dropdown list. To insert the image at the exact size you 



 

uploaded, simply select Full Size. Next to each size listed in this dropdown will be 

the actual dimensions of the image, in pixels (e.g. 300 x 225). 

Once you’ve selected all your images, click the Insert into post button to insert the 

selected image(s) into your Post at the current cursor position (when editing a 

Page, this button will say Insert into page). 

If you’d like to change the order of your images, click the Edit Selection link at the 

bottom of the Insert Media window. The window will change so that only the 

selected images are shown. Alternatively, clicking the Clear link will deselect all 

images. 

After clicking the Edit Selection link at the bottom of the Insert Media window, all 

the currently selected images are shown. You can change the order in which the 

images will appear in your Page or Post by clicking and dragging each image to 

reorder them. You can also update the image Title, Caption, Alt Text and 

Description for each image. To remove one of your selected images, click the small 

‘-’ that appears in the top right corner of the image when you hover your cursor 

over the tick. 

http://en.wikipedia.org/wiki/Alternate_text


 

 

Clicking the Return to library button will take you back to the previous screen that 

allows you to select or deselect your images. 

When you’re editing your Post/Page, if you wish to insert an image that you 

uploaded earlier (as opposed to uploading a new image), click the Add Media 

button again ( ). Once the pop-up window displays, click the 

Media Library tab at the top of the pop-up window rather than dragging a new file 

into the upload window. All your previously uploaded images will be displayed, 

with the most recent ones shown first. 

Select the image(s) that you’d like to insert into your Page or Post and then simply 

click the Insert into post button (or if you’re editing a Page, this button will say 

Insert into page). As mentioned earlier, you can also click the Edit Selection link at 

the bottom of the window if you’d like to change the order the images are 

inserted. 



 

Edit or Delete an Image 
There are various options available for adjusting the layout of inserted images. 

After clicking on an image that has already been inserted into your Page or Post, a 

small toolbar will appear over the image. By selecting one of the alignment 

buttons ( ) you can change the alignment of the inserted image. 

Clicking the Edit button ( ) allows you to edit the image properties. Clicking the 

Remove button ( ) will remove the image from your content. It will only 

remove the image from your Page or Post, it will not delete the image from your 

Media Library. 

When you click on an image in your Page or Post, as well as the alignment, edit 

and delete icons mentioned above, the image also displays ‘resizing handles’. 

These are the small squares you see around the edge of the image. To resize your 

image, simply click and drag one of the corner resize handles. 

As with any image editing software though, if you try to enlarge a small image, it 

will tend to get quite pixelated. It’s always best to insert a large image and then 

resize down. 



 

 

After clicking the Edit button ( ) the following pop-up window will appear. 



 

 

The Image Details pop-up window allows you to edit the various image and link 

properties: 

• Caption – Displayed underneath the image as a short description. How this 

displays will be dependent on the WordPress theme in use at the time. You 

can also include basic HTML in your captions 

• Alternative Text – Displayed when the browser can’t render the image. It’s 

also used by screen readers for visually impaired users so it’s important to 

fill out this field with a description of the image. To a small degree, it also 

plays a part in your website Search Engine Optimisation (SEO). Since search 

engines can’t ‘read’ images they rely on the Alt Text 

• Align – Allows you to select how you would like the image aligned. They can 

be either Left, Centered or Right aligned. Setting alignment to None will 

remove the other alignment settings. How this affects your image within 

your content will depend on the current theme in use 



 

• Size – Select a specific size from the dropdown list or select ‘Custom Size’ and 

then enter the Width and Height (in pixels) in the input fields that appear 

• Link To – Select where you would like to link your image to from the 

dropdown list. You have the choice of linking to the image attachment page 

by selecting Attachment Page, or you can link to the full size image by 

selecting Media File. You can also link to any URL by selecting Custom URL. 

When you do this, a new field will appear that allows you to enter in the 

custom URL. You can also choose not to link to anything by selecting None 

• Image Title Attribute – Displayed as a tooltip when the mouse cursor hovers 

over the image in the browser 

• Image CSS Class – By default, WordPress will assign several CSS Classes to 

your image. If, for some reason, there’s other CSS Classes that you’d like to 

assign to your image then you can add them into this input field 

• Link Rel – Describes the relationship from the current document to the 

specified link. More information on the rel HTML attribute can be found on 

Wikipedia 

• Link CSS Class – If there is a specific CSS Class that needs to be set on the 

HTML link then you can add it into this input field 

Clicking the Edit Original button allows you to perform some simple manipulation 

with your uploaded image. You’re able to rotate and flip your image as well as 

scale and crop it to different sizes. 

If you’d like to replace the image entirely, click the Replace button and you’ll be 

shown your Media Library where you can select a new image. 

Once you have updated the image properties, click the Update button to save your 

changes. Alternatively, click the small ‘x’ in the top-right of the pop-up window to 

close the pop-up without saving any changes. 

 

Setting a Featured Image 
Some themes allow you to specify a Featured Image for your Page and Post. A 

Featured Image, often called a Post/Page Thumbnail, is usually some sort of image 

http://en.wikipedia.org/wiki/Rel_attribute


 

that is representative for that particular Page or Post. How these images are 

displayed is dependent entirely on the Theme that is currently in use. 

If your Theme allows you to set a Featured Image, the following Featured Image 

panel will be displayed when you’re editing your Page or Post. If Featured Images 

can’t be set then this panel won’t be displayed. 

 

Setting your featured image is very similar to adding an image into your Page or 

Post. After clicking the Set featured image link a pop-up window will display that 

looks similar to the one that displays when you add an image to your Page/Post. 

You can upload a new image to use as your Featured Image or you can simply 

choose from one of your previously uploaded images. 

By default, you’ll be shown a list of the previously uploaded images. If you’d like 

to upload a new image, click on the Upload Files link at the top of the pop-up 

window. After clicking the image you’d like to use as your featured image you can 

then update the Title, Caption, Alt Text and Description. To set the image as your 

Featured Image, click the Set featured image button. Your chosen image will then 

appear in the Featured Image panel. 



 

 

Insert an Image Gallery 
WordPress has its own simple built-in Image Gallery that allows you to add 

multiple images to a page in one easy step. 

To insert an image gallery into your Page/Post, click the Add Media button (

). A pop-up window will display that looks the same as the one 

that displays when you add an image to your Page/Post. You can upload new 

images to use in your gallery or you can simply choose from your previously 

uploaded images. 

By default, you’ll be shown a list of your previously uploaded images. If you’d like 

to upload a new image, click on the Upload Files link at the top of the pop-up 

window. 



 

Click the Create Gallery link in the left-hand navigation then select the images that 

you’d like to insert into your gallery. 

 

After selecting your images, click the Create a new gallery button at the bottom of 

the pop-up window. The window will change so that only the selected images are 

shown. 



 

 

All the images that appear will be used within your Image Gallery. To reorder the 

images simply click on an image and drag it to its new position. If you’d like to 

add captions to your images, click the ‘Caption this image..’. text below each image 

and then type in your caption. Alternatively, click each image and then update the 

Title, Caption, Alt Text and Description on the right-hand side of the pop-up 

window. You can also include basic HTML, such as links, in your captions. 

If you decide you no longer want a certain image to appear in your gallery, click 

the small ‘-’ that appears in the top right corner of the image when you hover your 

cursor over the ‘x’. 

Since the built-in gallery is quite simple, there aren’t that many options to choose 

from when setting it up. 

• Link to – This sets what happens when the thumbnail image is clicked. 

Selecting Media File will open the full size image directly in your browser 



 

window. Selecting Attachment Page will open the image within one of your 

WordPress formatted pages 

• Columns – Specifies the number of columns to use when displaying your 

thumbnail images. Ultimately, this will be dependent on your Theme and 

how wide your page is. If you find the gallery isn’t displaying properly after 

changing this number you may need to change it to another number 

• Random Order – Click this checkbox to display your images in a random 

order 

• Size – Selects the size of the image to use in your gallery 

Edit or Delete an Image Gallery 
Editing or Deleting an Image Gallery is much like editing or deleting an image. 

After clicking on an Image Gallery that has been inserted into your Page or Post, 

two icons will appear on top of the gallery. Clicking the Edit button ( ) allows 

you to edit the image gallery properties. Clicking the Remove button ( ) will 

delete the image gallery from your content. It will only remove the image gallery 

from your Page or Post, it will not delete any images from your Media Library. 

 



 

After clicking the Edit icon you will be shown the same pop-up window and 

options as when your image gallery was inserted into your Page/Post. 

Insert an Audio or Video Playlist 
Inserting an audio or video playlist is almost identical to inserting an image 

gallery. Click the Add Media button ( ). A pop-up window will 

display that looks the same as the one that displays when you add an image to 

your Page/Post. You can upload new media files to use in your playlist or you can 

simply choose from your previously uploaded files. 

By default, you’ll be shown a list of your previously uploaded files. If you’d like to 

upload a new media file, click on the Upload Files link at the top of the pop-up 

window. 

To create an audio playlist, click the Create Audio Playlist link in the left-hand 

navigation. The pop-up window will display a list of your audio files. 

Alternatively, to create a video playlist, click the Create Video Playlist link in the 

left-hand navigation. The pop-up window will display a list of your video files. 



 

 

After selecting your media files, click the Create a new playlist button at the 

bottom of the pop-up window. The window will change so that only the selected 

media files are shown. 



 

 

All the media files that appear will be used within your playlist. To reorder the 

files simply click on a file and drag it to its new position. You can change the title 

for each file by clicking the text below each file and then typing in your new title. 

Alternatively, click each file and then update the Title, Caption and Description on 

the right-hand side of the pop-up window. 

If you decide you no longer want a certain media file to appear in your playlist, 

click the small ‘-’ that appears in the top right corner of the file when you hover 

your cursor over the ‘x’. 

You can change how your playlist appears in your page by selecting which items 

you’d like to appear. 

When inserting an audio playlist you have the following display settings. 

• Show Tracklist – Ticking this checkbox will show a list of all the audio files 

within your playlist 



 

• Show Artist Name in Tracklist – Ticking this checkbox will show the artists 

name next to each track name 

• Show Images – Ticking this checkbox will show any associated audio file 

images 

When inserting a video playlist you have the following display settings. 

• Show Video List – Ticking this checkbox will show a list of all the video files 

within your playlist 

• Show Images – Ticking this checkbox will show any associated video file 

images 

Inserting Video, Audio or Other File Type 
The procedure for inserting any other type of file into your Page/Post is exactly 

the same as Inserting an Image. Simply click the Add Media button (

). Once the relevant pop-up window displays, perform the same 

steps to upload your file to your site and to insert it into your Page or Post. 

When inserting video or audio files, you can select Embed Media Player from the 

Embed or Link dropdown list in the Insert Media pop-up window to use the audio 

and video players that are now built into WordPress. Supported audio/video 

formats include M4a, MP4, OGG, WebM, FLV, MP3, and WAV files. 

 



 

 

 

It’s recommended that you make your filename ‘server friendly’. Make 
sure the filename has no spaces, apostrophes, slashes or other non-
alphanumeric characters (such as $, % and &). Rename the file before 
uploading if it does. To preserve readability, some people replace 
spaces with the underline character or hyphen. For instance, My File 
Name.txt becomes My_File_Name.txt or My-File-Name.txt 

 

Embedding a Video, Image or Other Content 
Another way to add video or other content into your pages is through embedding. 

A popular example of this is embedding a YouTube video into your page. 

When you’re embedding a file, there’s no need to upload the file to your site. 

You’re basically just creating a link to the file, from within your own page. 



 

WordPress is able to automatically embed files from a number of different 

services. 

To embed something into your Post or Page, simply paste the URL into your 

content area. The URL needs to be on its own line and not hyperlinked. 

 

When embedding content in this manner (as opposed to using the embed 

shortcode mentioned below), your url will change to show a preview of that 

content. For example, when embedding a video from YouTube, after pasting in 

the URL to the editor, it will magically change to show the actual video content, 

right there in the editor. 



 

 

If you’d like to specify the width and height, you can wrap the URL in the [embed] 

shortcode. Embedding your link using this shortcode does not require the URL to 

be on its own line. The format for using the shortcode is: 

 [embed width= “123” height= “456”] url [/embed] 

WordPress will automatically embed content from the following sites: 

• Animoto 

• blip.tv 

• Cloudup 

• CollegeHumor 

• DailyMotion 

• Facebook 

• Flickr 

http://codex.wordpress.org/Shortcode_API
http://animoto.com/
http://blip.tv/
https://cloudup.com/
http://www.collegehumor.com/
http://www.dailymotion.com/
http://facebook.com/
http://www.flickr.com/


 

• FunnyOrDie.com 

• Hulu 

• Imgur 

• Instagram 

• Issuu 

• Kickstarter 

• Meetup.com 

• Mixcloud 

• Photobucket 

• Polldaddy 

• Reddit 

• ReverbNation 

• Scribd 

• SlideShare 

• SmugMug 

• SoundCloud 

• Speaker Deck 

• Spotify 

• TED 

• Tumblr 

• Twitter 

• VideoPress 

• Vimeo 

• Vine 

• WordPress Plugin Directory 

http://www.funnyordie.com/
http://www.hulu.com/
http://imgur.com/
http://instagram.com/
http://issuu.com/
https://www.kickstarter.com/
http://meetup.com/
http://www.mixcloud.com/
http://photobucket.com/
http://www.polldaddy.com/
https://www.reddit.com/
https://www.reverbnation.com/
http://www.scribd.com/
http://www.slideshare.net/
http://www.smugmug.com/
https://soundcloud.com/
https://speakerdeck.com/
https://www.spotify.com/
http://www.ted.com/
https://www.tumblr.com/
https://twitter.com/
http://videopress.com/
http://vimeo.com/
https://vine.co/
https://wordpress.org/plugins


 

• WordPress.tv 

• YouTube (only public and "unlisted" videos and playlists) 

http://wordpress.tv/
http://www.youtube.com/


 

Adding HTML Links 
HTML links allow your site visitors to easily navigate around your site. They’re 

also used when you want to allow people to download files from your site, such as 

PDFs or other documents, for viewing images or even just linking to other 

websites. HTML links will frequently be shown with an underline to differentiate 

it from other text, but this may vary depending on the theme you’re currently 

using. 

Inserting an HTML Link 
Inserting an html link in your Page/Post to one of your own pages or another site 

is extremely easy. Simply click and drag the cursor and highlight the text that you 

want turned into a link and then click the Insert/edit link button ( ). A small 

inline link toolbar will display where you can enter your link URL. If you enter a 

URL without including ‘http://’ in front of it, WordPress will automatically correct 

it for you. As an example, if you type ‘google.com’ it will automatically correct this 

to ‘http://google.com’. After you’ve entered your link url, hit your Enter key or 

click the Apply button ( ) to save your changes. 

If you don’t select any text prior to clicking the Insert/edit link button, it will use 

the URL that you enter as the link text. 

You can also insert a link to one of your existing Posts or Pages by simply typing 

the Post or Page name and then selecting it from the list that displays. As you type 

the Post/Page name the list will re-populate based on matching results. 



 

 

If the URL that you enter in the inline link toolbar has the incorrect syntax, 

WordPress will let you know by highlighting the link with a red dotted outline. 

When this happens, simply click the link to display the inline link toolbar again 

and then click the Edit button ( ) to edit the URL you entered. 

 

If you wish to display the pop-up window that previously displayed prior to 

WordPress 4.5, click the Link options icon ( ). This pop-up is also useful if you 

wish to have your link open in a new tab/window when clicked as it gives you 

access to the Open link in a new tab checkbox. 



 

 

If you’re displaying the pop-up window, simply fill in URL and the Title and then 

click the Add Link button.  

• URL – URL of the page or website that you would like to create a link to 

• Link Text – The text that you highlighted prior to clicking the Insert/edit link 

button will be automatically displayed 

• Open link in a new tab – When someone clicks the link you can have it open 

in the same window (default setting) or have it open in a new browser 

window/tab 

Alternatively, if you’d like to add a link to one of your existing Posts or Pages, 

select the relevant page from the supplied list. If you have a large number of 

pages within your site, you can type the Page or Post name in the Search field to 

make it easier to find. As you type, the list will re-populate based on matching 

results. After selecting one of your existing pages, the link will be updated in the 

URL field. Click the Add Link button to add your link. 



 

Inserting Links to Media Files 
Adding a link to media files such as documents or PDF’s is just as easy as adding a 

standard html link. There are a couple of ways you can go about it. 

Click the Add Media button ( ) and then simply drag your file from 

wherever it is on your computer, into the browser window. Your file will be 

automatically uploaded. 

Alternatively, click the Select Files button and then select the file that you’d like to 

upload, using the dialog window that is displayed. 

Once your file is uploaded, your Media Library, which contains all your 

previously uploaded files, is displayed. The file that you’ve just uploaded will be 

automatically ‘selected’ for easy insertion into your Page or Post. 

 



 

Update the Title for your file. The Title will be used for the text link when it’s 

inserted into your content. From the Link To dropdown list, select Media File. The 

field just below this will be automatically populated with the URL for the file. 

Click the Insert into post button to insert a link to the selected file in your Post at 

the current cursor position (when editing a Page, this button will say Insert into 

page). 

If you happen to know the URL for the media file that you’d like to link to or if 

you’d like to create a link on some existing text, simply click and drag the cursor 

and highlight the text that you want turned into a link and then click the 

Insert/edit link button ( ). Just like previously, when adding a simple HTML 

link, enter the URL to your media file and then click the Add Link button. A 

standard html link will be created that links to the media file that you specified. 

Editing an HTML Link 
To edit an html link, click the link within your Page/Post that you’d like to edit to 

display the inline link toolbar. Once the toolbar appears, click the Edit button (

) to display the edit field. Alternatively, click the link within your Page/Post and 

then click the Insert/edit link button ( ) on the main Visual Editor toolbar. 



 

 

After you’ve updated the link url, hit your Enter key or click the Apply button (

) to save your changes. If you wish to display the Insert/edit link pop-up 

window click the Link options icon ( ). 

 



 

Removing an HTML Link 
To remove an html link, click the link within your Page/Post that you’d like to 

remove to display the inline link toolbar. Once the toolbar appears, click the 

Remove button ( ) to remove the link. Alternatively, click the link to position 

the cursor somewhere within it and then click the Remove link button ( ) on 

the main Visual Editor toolbar. If you want to remove a link from an image, 

simply click the image once to select it and then click the Remove link button (

) on the main Visual Editor toolbar. If the html link is linking to an uploaded file 

or image, clicking the Remove link button won’t remove or delete that file, it will 

simply remove the hyperlink. 

 



 

Editing Existing Content 
To edit an existing page, simply click on the relevant Page/Post title, when viewing 

your list of Pages or Posts. Alternatively, click on the Edit link that appears 

beneath the title when hovering your cursor over each row. 

 

The screen that appears will be exactly the same as the Add New Page/Add New 

Post screen, only with the existing content displayed. When you’ve finished 

editing your Page/Post, click the Update button. 



 

Deleting Content 
If you wish to delete one of your Pages or Posts, click on the Trash link that 

appears beneath the title when hovering your cursor over each row. This will 

move the Page/Post to the Trash. 

 

To delete the Page/Post permanently or to restore the Page/Post, click the Trash 

link at the top of the screen. When the cursor is hovering over each item in the 

Trash, the Restore and Delete Permanently links appear. Click Delete Permanently 

to permanently remove a single Page or Post. Clicking Restore will restore the 

Page or Post. 

 

If you would like to permanently delete or restore numerous items at once, click 

the checkboxes next to the items you would like to delete or restore and then 



 

choose either Restore or Delete Permanently from the Bulk Actions dropdown list 

at the top of the page. After selecting the appropriate action click the Apply button 

to make your change. Alternatively, click the Empty Trash button to delete all the 

items in the Trash. 



 

Fullscreen Editing 
WordPress allows for fullscreen composing. It provides for complete distraction 

free editing of your Page or Post. To enter fullscreen mode simply click on the 

Distraction Free Writing button ( ). With the Distraction Free Writing button 

turned on, the left-hand menu and the right-hand side panels fade out of view, 

leaving the screen with just the minimal required to compose your content. 

 

In Distraction Free Writing mode, only the Title field and Visual Editor is 

displayed until you move your cursor outside of the editor. Once you move your 

cursor outside of the editor, the menu and side panels fade back into view. 

To exit from Distraction Free Writing mode, click on the Distraction Free Writing 

button again. 



 

Saving and Publishing Content 
Once you’ve added all your content to your Page or Post you have the option of 

Saving the Page as a Draft or Publishing the page. Clicking the Save Draft button 

will simply save your Page/Post. This is handy if you would like to come back at a 

later date to add more content or if you’re simply not ready to publish yet. 

 

Clicking the Publish button will save your Page/Post and publish it on your 

website. 

Clicking the Preview button will show you a preview of the current Page/Post. 

There are also several options available when saving. By default the Status is set 

to Draft but this can be changed by clicking the Edit link just to the right of Status: 

within the Publish panel. 

• Pending Review means the draft is waiting for review by an editor prior to 

publication. 

• Draft means the post has not been published and remains a draft for you. 

You can also change the visibility of the Page by clicking the Edit link just to the 

right of Visibility: within the Publish panel. 



 

• Public is the default and means the page is viewable to all. There is also an 

option to make the Post ‘sticky’. Sticky posts are placed at the top of all blog 

posts and stay there even after new posts are published. 

• Password Protected allows you to assign a password to your page. Only 

people who have the password will be able to access the page. 

• Private hides the content from the public completely. Normal users and 

visitors will not be aware of private content. You will only see the private 

content when you are logged into your WordPress blog. 

Just below the Title for your content is the full URL for your Page or Post. Clicking 

this will take you to the published page, or if the page hasn’t been published yet, a 

preview of the page. Clicking the Edit button next to the URL allows you to change 

the Permalink (i.e. the URL) of the Page or Post. You might decide to do this for 

improving SEO (Search Engine Optimisation). Most times though, you’ll simply 

leave the default URL which WordPress automatically generates based on your 

Page/Post Title. 

By default, when you click the Publish button your Page/Post is published 

immediately. To change this, click the Edit link just to the right of Publish 

immediately within the Publish panel. You can then select the date and time that 

you’d like to schedule your Page/Post to be published. You must also click the 

Publish button when you have updated the date and time fields to publish at the 

desired date and time. 

 



 

Categories 
You can use categories to define sections of your site and group related posts. The 

default category is Uncategorized but this can be easily changed in your Settings. 

Pages cannot be associated with Categories. You can only associate Categories to 

Posts. 

There are two ways to add Categories. They can be added whilst adding or editing 

your Post or they can be added via the Categories menu option. Adding Categories 

whilst editing your Post, will automatically assign those Categories to your Post. 

Adding Categories using the Categories menu option will simply add them to the 

list of available Categories. 

When you click on the Categories menu option you’ll be shown a list of Categories 

that have already been added along with some blank fields that allow you to add a 

new Category. 

 



 

To add a new Category, fill in the blank fields and then click the Add New Category 

button: 

• Name – The name is how it appears on your site 

• Slug – The Slug is the URL-friendly version of the name. It’s usually all 

lowercase and contains only letters, numbers, and hyphens 

• Parent – Categories, unlike tags, can have a hierarchy. You might have a Car 

category, and under that have children categories for Ford, General Motors 

and Toyota. Totally optional. To create a subcategory, just choose another 

category from the Parent dropdown 

• Description – The description is not prominent by default; however, some 

themes may display it 

Once you add a new Category it will appear in the list of Categories on the right 

side of the screen. 

When hovering your cursor over each row in the list of Categories, a few links will 

appear beneath the Category name. 

• Edit – Allows you to edit the Category properties such as Name, Slug, Parent 

and Description 

• Quick Edit – Allows you to quickly edit the Category Name and Slug 

• Delete – Deletes the Category permanently from the list of Categories. After 

clicking Delete you will be prompted to confirm your choice. Click OK to 

delete the Category or Cancel if you don’t want to delete it 

• View – This will list all the Posts that are currently using this Category 

If you would like to permanently delete numerous Categories at once, click the 

checkboxes next to the Categories you would like to delete and then choose Delete 

from the Bulk Actions dropdown list at the top of the page. After selecting Delete, 

click the Apply button to immediately delete the selected Categories (you will not 

be prompted to confirm your choice). 

Deleting a Category does not delete the posts in that Category. Instead, posts that 

were only assigned to the deleted Category are set to the default Category, which 

is set to Uncategorized by default. The Default Post Category can be configured 

within the Settings > Writing section. 



 

Adding Categories within your Post 
Adding Categories whilst editing your Post will automatically assign those 

Categories to your Post. 

When adding or editing your Post, the Categories panel can be found just below 

the Format panel if your Theme supports Post Formats. Alternatively, it will 

reside just below the Publish panel. To add an existing Category, simply tick the 

checkbox(es) next to the Categories you’d like to assign to the Post. 

 

If you would like to create a new Category and assign it to the Post at the same 

time, click the + Add New Category link. Two fields will then appear. Type the 

name of the Category that you’d like to add into the empty input field. If you’d like 

the new Category to have a Parent, select it from the Parent Category dropdown 

list. Click the Add New Category button when done to create the Category and 

automatically assign it to the Post. 



 

Tags 
Tags are ad-hoc keywords that identify important information in your post 

(names, subjects, etc) that may or may not recur in other posts. Unlike Categories, 

Tags have no hierarchy, meaning there’s no relationship from one Tag to another. 

Pages cannot be assigned Tags and cannot be associated with Categories. You can 

only associate Tags and Categories to Posts. 

Like Categories, there are two ways to add Post Tags. They can be added whilst 

adding or editing your Post or they can be added via the Tags menu option. 

Adding Tags whilst editing your Post, will automatically assign those Tags to your 

Post. Adding Tags using the Tags menu option will simply add them to the list of 

available Tags. 

When you click on the Tags menu option you’ll be shown a list of Tags that have 

already been added, along with some blank fields that allow you to add a new 

Tag. A list of Popular Tags is also displayed in ‘cloud’ format. That is, the Tags are 

displayed in alphabetical order and the more often a Tag has been used, the larger 

the font it’s displayed in. 



 

 

To add a new Tag, fill in the blank fields and then click the Add New Tag button: 

• Name – The name is how it appears on your site 

• Slug – The Slug is the URL-friendly version of the name. It’s usually all 

lowercase and contains only letters, numbers, and hyphens 

• Description – The description is not prominent by default; however, some 

themes may display it 

Once you add a new Tag it will appear in the list of Tags on the right side of the 

screen. 

When hovering your cursor over each row in the list of Tags, a few links will 

appear beneath the Tag name.  

• Edit –Allows you to edit the Tag properties such as Name, Slug and 

Description 



 

• Quick Edit – Allows you to quickly edit the Tag Name and Slug 

• Delete – Deletes the Tag permanently from the list of Tags. After clicking 

Delete you will be prompted to confirm your choice. Click OK to delete the 

Tag or Cancel if you don’t want to delete it 

• View – This will list all the Posts that are currently using this Tag 

If you would like to permanently delete numerous Tags at once, click the 

checkboxes next to the Tags you would like to delete and then choose Delete from 

the Bulk Actions dropdown list at the top of the page. After selecting Delete, click 

the Apply button to immediately delete the selected Tags (you will not be 

prompted to confirm your choice). 

Adding Tags within your Post 
Adding Tags whilst editing your Post, will automatically assign those Tags to your 

Post. 

When adding or editing your Post, the Tags panel can be found just below the 

Categories panel. To add an existing Tag, click the Choose from the most used tags 

link. This will display a list of previously used Tags (if available). They are 

arranged alphabetically and in ‘cloud’ format. That is, the more often a Tag has 

been used, the larger the font it’s displayed in. To add a previously used Tag, 

simply click on the Tag name and it will be assigned to your Post. To add a new 

Tag, simply write the Tag or Tags (separated with commas) into the edit field and 

click the Add button. Tags that are assigned to the Post will be displayed below the 

edit field. To remove a Tag from your Post, click the small ‘x’ icon next to the Tag 

name. 



 

 



 

Media Library 
The Media Library is where you can find all the files that you’ve uploaded. There 

are two different types of views you can select from when viewing your media 

library. You can click the List View icon ( ) to display your images in a list, or 

you can click the Grid View icon ( ) to view your images in a Grid layout. 

The Grid View will display a grid of thumbnail images for each of your media 

files. The Grid View employs infinite scrolling, rather than displaying your images 

over multiple pages. To view more images, simply scroll to the bottom of the page 

and more thumbnails are automatically loaded. 

 

 

The List View will display your images vertically down the page, over multiple 

pages. By default, it will display 20 images per page but you can change this 

number by clicking the Screen Options link at the top-right of the page and 

changing the Number of items per page. 



 

 

Both views show the most recently uploaded files first. There are also dropdown 

lists that allow you to filter the list of files that are currently being displayed, 

along with a search field to help search for files. 

Within the List View, the list of files contains a small thumbnail version of the 

image or file, the file title and the file name along with the file extension which 

shows the type of file (JPG, MP3, etc.), the name of the Author who uploaded the 

file, the Page or Post which the image was uploaded to, the number of comments 

and the date the file was uploaded. 

When hovering your cursor over each row in the List View, a few links will 

appear beneath the file name.  

• Edit – Allows you to edit the file properties such as Title, Alt Text, Caption and 

Description. You can also perform some basic image manipulation 

• Delete Permanently – Deletes the file permanently from the Media Library 

• View – Will take you to the display page for that file 



 

Viewing a File in the Media Library 
The Grid View will display a grid of thumbnail images for each of your media 

files. Depending on the file type, you’ll either see a thumbnail image for that 

particular file or an icon representation. 

After clicking on a thumbnail within the Grid View, a pop-up window will display 

the properties for that particular file, along with giving you the ability to update 

certain properties. If the file is an image, you’ll also see a larger version of that 

image. For supported audio and video files (M4a, MP4, OGG, WebM, FLV, MP3, 

and WAV) you’ll see the appropriate media player. For other file types such as 

PDF’s or Word Documents, there is a link to view the attachment page which in 

turn has a link to the actual file. 

 

Within the List View, you can click the thumbnail image, the media file title or you 

can hover the cursor over the row and click the Edit link. The various file 



 

properties will be displayed, along with giving you the ability to update certain 

properties. If the file is an image, you'll see a larger version of that image. For 

supported audio and video files (M4a, MP4, OGG, WebM, FLV, MP3, and WAV) 

you’ll see the appropriate media player. For other file types such as PDF’s or Word 

Documents, you’ll simply see the file properties along with a button to view the 

attachment page which in turn has a link to the actual file. 

 

Clicking the View link, when hovering your cursor over a row, will display the 

attachment page for that particular media file. If the file is an image, you'll see a 



 

larger version of that image. For supported audio and video files you’ll see the 

appropriate media player and for other file types such as PDF’s or Word 

Documents, you’ll see a link to the actual file. 

 

Adding a File to the Media Library 
To add a new file to the Media Library, click on the Add New link in the left-hand 

navigation menu or the Add New button at the top of the page. 

If you click the Add New button when you’re viewing the Media Library in the List 

View, or click the Add New link in the menu, simply drag your images from 

wherever they are on your computer, into the area marked Drop files here. Your 

file(s) will be automatically uploaded. 

Once your images or files are uploaded, they’re listed below the file uploader. If 

you’d like to edit the file properties, click the Edit link next to the file. 



 

 

If you click the Add New button when you’re viewing the Media Library in the 

Grid View, you can drag your images from wherever they are on your computer, 

to anywhere on the screen. Your file(s) will be automatically uploaded. 

Once your images or files are uploaded, they’re displayed below the file uploader, 

with the rest of your media. 

 



 

 

When uploading files, you can also click the Select Files button and then select the 

files that you’d like to upload, using the dialog window that is displayed. 

Editing the File Properties 
If you’re viewing your files using the Grid View, simply click on one of your media 

files and you’ll be presented with a pop-up window that displays the relevant 

properties for that particular file. 

After updating each field your changes will be automatically saved. You can use 

the arrow buttons at the top of the pop-up window to navigate to the previous or 

next image. Click the ‘x’ in the top-right of the pop-up window to return to the 

media Grid View. 

 

To edit the properties of an existing file when using the List View within the 

Media Library, hover the cursor over the particular row that contains the file you 

wish to edit and click the Edit link. Alternatively, you can also click the file title or 

the thumbnail image. Clicking the Edit link next to the file after it’s just been 

uploaded, will also allow you to edit its properties. 



 

After clicking Edit, the relevant properties for that particular media file are 

displayed, including the title, URL, filename, file type and in the case of an image, 

the file dimensions. When editing the file properties, the Alternative Text field will 

only be displayed for images. 

 

• Title – Although the field isn’t labelled, the Title is the field at the very top of 

the page (when editing the image from the List View). The Title is displayed 

as a tooltip when the mouse cursor hovers over the image in the browser 

• Caption – is displayed underneath the image as a short description. How this 

displays will be dependent on the WordPress theme in use at the time. You 

can also include basic HTML in your captions 



 

• Alternative Text – This field is only displayed for image files. The 

Alternative Text is displayed when the browser can’t render the image. It’s 

also used by screen readers for visually impaired users 

• Description – This content is displayed on the file’s attachment page 

• Metadata - Artist – This field is only displayed for audio files. It allows you to 

specify the recording artist 

• Metadata - Album – This field is only displayed for audio files. It allows you 

to specify the album to which the audio file belongs to 

Once the file properties are updated click the Update button to save your changes. 

Editing an Image 
WordPress has a basic image editing tool that allows you to perform some simple 

manipulation with your uploaded images. You’re able to rotate and flip your 

images as well as scale them and crop them to different sizes. 

When editing the file properties of an image (as opposed to other file types like 

documents or PDFs), click the Edit Image button that appears just below the image 

to show the image editing tools. 

If you click the Edit Image button whilst using the Grid View, the image editing 

tools will appear in the pop-up window. 



 

 

If you click the Edit Image button whilst using the List View, your page will look 

slightly different to the above Grid View. As well as the image editing tools, you’ll 

also see the properties of the file such as the file size and dimensions. You can also 

still update the Caption, Alternative Text and Description. 



 

 

No matter what view you’re using, just above the image you’ll find the following 

image editing buttons: 

 

Crop – Click on the image and drag the selection box to the size 
that you’d like the image cropped. Click the Crop button to crop 
the image to the new size 

 

Rotate counter-clockwise – Rotate the image 90° counter-
clockwise 



 

 

Rotate clockwise – Rotate the image 90° clockwise 

 

Flip vertically – Flip the image vertically 

 

Flip horizontally – Flip the image horizontally 

 

Undo – Undo the last change 

 

Redo – Redo the last change 

 

To scale your image to a new size, simply enter the width or height dimensions in 

the appropriate field and click the Scale button. For best results, scaling should be 

done before performing any other operations like cropping, flipping or rotating 

the image. It’s important to note that images can only be scaled down, not up. 

After entering one scale value, the other value will change automatically so as to 

keep the image in proportion. The original image dimensions are displayed just 

above the input fields, for your reference. 

There are several ways to crop your image. The easiest is to simply click on the 

image and drag the selection box to the appropriate size. If you’d like your image 

cropped to a specific ratio, enter the values in the Aspect Ratio input fields (e.g. 1:1 

(square), 4:3, 16:9 etc.). You can then hold down the shift key and drag one of the 

edges of your selection to enlarge or reduce the size, while keeping this aspect 

ratio locked. If there is already a selection made, specifying the aspect ratio will 

automatically change the selection to match it. 

Whenever the selection box is adjusted, the dimensions are displayed in the 

Selection input fields. You can also manually enter the dimensions of the selection 

box (in pixels) by entering values into these two fields. Once your selection box is 



 

adjusted, simply click the Crop button just above the image to crop the image to 

this new size. 

By selecting one of the options in the Thumbnail Settings panel, you have the 

option to apply your changes to All image sizes, just the Thumbnail image or All 

sizes except Thumbnail. 

Click the Save button to save your changes. 

Click the Update button to return to the main Media Library page. 

If you’d like to revert back to your original image, click the Edit Image button 

again to return to the image editor. A new Restore Original Image link is displayed 

just below the Scale Image link. Click the Restore Original Image link and then 

click the Restore image button to discard your changes and restore your original 

image. 

 

Deleting a File from the Media Library 
To delete a file from the Media Library when using the Grid View, first click an 

image to view the File Properties, then click on the Delete Permanently link that 

appears in the pop-up window. 



 

 

To delete a file from the Media Library when using the List View, click on 

the Delete Permanently link that appears beneath the file name when hovering 

your cursor over each row. 

 

After you click the Delete Permanently link in either view, you’ll be prompted with 

a confirmation message. 



 

Click the OK button to delete the file or click the Cancel button to return to the 

Media Library. 



 

Comments 
Comments are a feature of blogs which allow readers to respond to Posts. 

Typically, readers simply provide their own thoughts regarding the content of the 

post, but they may also provide links to other resources, generate discussion, or 

simply compliment the author for a well-written post. Comments allow you to 

interact more with your site visitors as well as generate feedback and discussion 

on your Posts. 

Comments can be controlled and regulated through the use of filters for language 

and content, and if you prefer, can also be queued for approval before they are 

visible on the web site. This is useful in dealing with comment spam. 

When you click on the Comments menu option, you’ll be shown a list of all the 

comments on your site. 

 

At the top of the screen there are links that allow you filter the comment list to 

only show the comments that are Pending, Approved, Marked as Spam or that are 

in the Trash. The number in brackets will advise how many there are for that 

particular type. 

http://codex.wordpress.org/Comment_Spam


 

As well as the standard settings that allow you to manage your comments, the 

default WordPress install comes with an excellent plugin that helps to filter out 

spam from your comments. This plugin is called Akismet. 

After activating the Akismet plugin, you need to supply it with an API Key. You 

can grab an API key and find out more information on the Akismet website. 

When hovering your cursor over each row in the list of Comments, a few links 

will appear beneath the comment.  

• Unapprove/Approve – Allows you to unapprove the comment. This will stop 

it displaying on your site. If the comment is already unapproved then this 

link will change to Approve, to allow you to approve the comment 

• Reply – Allows you to write a reply comment 

• Quick Edit – Allows you to quickly edit the commenter’s Name, Email or URL 

as well as the actual comment 

• Edit – Allows you to edit the commenter’s Name, Email or URL as well as the 

actual comment. It also allows you to mark the comment as either Approved, 

Pending or Spam and change the Date and Time 

• Spam – Allows you to mark the comment as spam 

• Trash – Allows you to mark the comment as Trash. Once it’s in the Trash, you 

can either restore it if you made a mistake, or delete it permanently 

If you would like to change the status of numerous Comments at once, click the 

checkboxes next to the Comment(s) you would like to change and then choose 

either Unapprove, Approve, Mark as Spam or Move to Trash from the Bulk Actions 

dropdown list at the top of the page. After selecting the appropriate option, click 

the Apply button. 

Replying to a Comment 
To respond to a comment that someone has written on one of your Posts, simply 

hover the mouse over the comment and click the Reply link when it appears. An 

edit field will then appear beneath the comment where you can type your reply. 

http://akismet.com/


 

 

When you’ve written your comment, click the Reply button or alternatively, click 

Cancel to stop replying and cancel your editing. 

The editor that appears when replying or editing a comment (using either the 

Reply, Quick Edit or Edit links) is much like the editor when creating or editing a 

Page or Post, only not as intuitive. At the top of the editor there are numerous 

formatting buttons. These buttons provide you with basic html formatting 

capabilities when composing a new reply comment or editing an existing 

comment. 

The buttons work in two ways. Clicking a button without highlighting any text 

first, will simply insert the opening html tag relevant for that button. As an 

example, clicking the Bold button will insert the <strong> html tag into your 

comment. Clicking the Bold button again will close the tag by inserting the closing 

</strong> tag. If you highlight some text prior to clicking a button, both the 

opening and closing tags will be inserted around that highlighted text. For 

example, highlighting the text, ‘bold text’, prior to clicking the Bold button will 

insert ‘<strong>bold text</strong>’. 

 
Bold – Bold text 



 

 
Italic – Italicise text 

 
Link – Used to insert a website link. When the button is clicked 
a pop-up window will appear where you type in the URL that 
you would like to link to 

 
Blockquote – Used as a way of showing a quote. How this looks 
will be entirely dependent on the Theme that your site is 
currently using 

 

Delete - Used as a way of showing deleted text. How this looks 
will be dependent on the Theme but is usually done by 
showing the text with a strikethrough 

 
Insert - Used as a way of showing inserted text. How this looks 
will be dependent on the Theme but is usually done by 
showing the text with an underline 

 
Image – Used to insert an image into the comment. When the 
button is clicked a pop-up window will appear where you type 
in the URL of the image that you would like inserted 

 
Unordered List – Used to insert an unordered (or un-
numbered) list 

 
Ordered List – Used to insert an ordered (or numbered) list 

 
List Item – Used to insert a list item into your ordered or un-
ordered list 

 

Code – Used for indicating a piece of code 

 
Close Tags – Used to close open tags. If for example, you 
clicked both the Bold and Italic buttons to insert their opening 
tags, clicking the close tags button will insert both of the 
matching closing tags, in the correct order 



 

 

Editing a Comment 
There are two ways to edit a comment. Once you hover over an individual 

comment you can click the Quick Edit link or the Edit link. Both perform a similar 

function except that the Edit option also allows you to mark the comment as 

either Approved, Pending or Spam as well as change the Date and Time. 

Quick edit 
Clicking Quick Edit will replace the comment with an editor that allows you to 

update the comment, the comment authors name, email address and URL. 

 

Once you have finished, click Update Comment to save your changes or click 

Cancel to cancel your changes and return to the list of comments. 

Edit 
Clicking Edit will display the editor on a new page. Like the Quick Edit option, you 

can update the comment, the comment authors name, email address and URL. 

The Edit option also gives you the ability to set the comment Status and change 

the comment Date and time. The comment status can be set to Approved, Pending 

or Spam. You also have the option to move the item to the Trash by clicking on the 

Move to Trash link. 



 

 

You can change the date and time that the comment was submitted by clicking on 

the Edit link next to the date and time. After clicking Edit, several fields appear 

below the original date and time. Update the fields if required and click the OK 

button to save the new date and time. 

Once you have finished updating the comment, click the Update button to save 

your changes. If you want to cancel your changes, click the browser Back button 

or click on the Comments menu option to return to the list of comments. 

Unapproving and Approving Comments 
If an inappropriate comment has been submitted, you may wish to Unapprove it. 

This will stop the comment from displaying on your site. Hover your cursor over 

the comment and click the Unapprove link to unapprove the comment. 

Comments that are already Unapproved will be displayed with a different 

coloured background within your list of comments. They will also be highlighted 

with a red vertical bar down the left side of the row. Hovering your cursor over 

the comment will display an Approve link instead of an Unapprove link. 



 

 

Marking Comments as Spam and Trash 
If a spam comment has been posted to your site you can mark it as spam simply 

by hovering your cursor over the comment and clicking the Spam link. If you’re 

using the Akismet plugin and you come across a spam comment that Akismet 

missed, marking it as spam will help Akismet learn and it will be less likely to 

miss similar spam in the future. 

If you simply want to remove a comment, hover your cursor over it and click the 

Trash link. 

 



 

To empty the Trash, click on the Trash link at the top of the page to display all the 

comments that have been marked as Trash. This link will be displayed along with 

a number within brackets which indicates how many comments are marked as 

Trash. To permanently remove all these comments, click the Empty Trash button. 

You will not be prompted for confirmation. 

To remove all the spam comments, click on the Spam link at the top of the page to 

display all the comments that have been marked as spam. This link will be 

displayed along with a number in brackets which indicates how many spam 

comments there are. To permanently remove all these comments, click the Empty 

Spam button. You will not be prompted for confirmation. 

You can also delete a single spam comment permanently by clicking on the Delete 

Permanently link that appears when hovering your cursor over each row. You will 

not be prompted for confirmation. 

 

If you find there are comments that have been marked as spam that shouldn’t be, 

click the checkboxes next to them and select Not Spam from the Bulk Actions drop 

down at the top of the page. Click the Apply button to confirm your choice. 

Alternatively, click the Not Spam link that appears when hovering your cursor 

over each row. 



 

Appearance 
The various Appearance menus allow you to change how your site looks and 

behaves. If your site has been setup for you by a third party then it’s more than 

likely that you won’t need to change any of the settings in here. 

Depending on the theme that your site is running, you may find that you don’t 

have all the menu options listed here, or you may have a couple of different ones. 

The reason for this is that a couple of the options under the Appearance section 

are theme based. For example, the default Twenty Seventeen theme allows you to 

customize options for how your theme displays. Not all themes will have these 

option pages, or if they do, they may be under another menu entirely. 

Selecting your Theme 
The overall appearance of a WordPress site is controlled by the Theme. Although 

there is a default theme that comes installed with WordPress, most people will 

either download a new theme, purchase one, or have one custom designed and 

built. There are hundreds of places where themes can be downloaded for free 

and/or for a small fee. One of the best places to start looking for themes is in the 

official WordPress Themes Directory. 

Clicking on the Appearance menu option will default you at the Themes screen. 

The theme that is currently active is shown at the top left of the screen. The other 

themes shown are ones that are installed, but not currently in use. To see a 

preview of your site in another theme (that isn’t currently active), you can click 

the Live Preview button associated with each theme. While the preview screen is 

displayed, you’re able to click your site links to view your various pages in the 

new theme layout as well as make various theme changes. To change your site to 

another Theme, hover your cursor over the theme you’d like to activate and click 

the Activate button that appears underneath the Theme. Alternatively, if the 

preview window is displaying, you can click the Save & Activate button in the top 

left corner of the window to activate the theme. 

To view more details about a particular theme, hover your cursor over a theme 

thumbnail image and click on Theme Details. A pop-up window will appear that 

displays a larger image along with the theme description and other details. 

http://wordpress.org/themes/


 

Clicking on the Add New button at the top of the page allows you to upload a new 

theme to your site as well as search the WordPress Themes Directory for new 

themes and install them directly from within your Dashboard. 

 

Previewing and Customizing your Theme 
As well as the ability to preview a theme, you can also update various theme 

settings all while previewing the changes live. The options that you can change 

will be dependent on the individual theme. 

For the currently active theme, clicking the Customize button allows you to update 

various settings whilst also previewing those changes. Until you click the Publish 

button, only the theme preview window is updated, not the theme on your live 

site. 

For all other installed themes that are not currently active, click the Live Preview 

button to preview the theme, update its settings and activate the theme. Until you 

click the Activate & Publish button, only the theme preview window is updated, 

not the theme on your live site. 



 

 

Adding a new Theme 
You’re able to add new themes to your site right within the WordPress 

Dashboard. At the top of the Themes screen there is an Add New button. Click this 

button to search and add new themes into your site.  

After clicking the Add New button, you’ll be shown the Add Themes screen. It 

should look similar to the screen below. The Add Themes screen allows you to 

search and install themes directly from the official WordPress Themes Directory. 

By default, the screen will show a list of Featured themes. 

You can use the links at the top of the page to filter the results to see Featured 

themes, Popular themes or the Latest themes. Click the Feature Filter link to filter 

the results based on the Tags you specify. There are Tags for Layout, Features and 

Subject. 

http://wordpress.org/themes/


 

Alternatively, click the Search themes... input field and enter text to search for a 

specific theme. 

 

Hovering your cursor over each theme thumbnail will display extra buttons. To 

view the details of a theme along with a preview, click the large Details & Preview 

button or the smaller Preview button. Clicking the Install button will download 

and install the theme on your site. After the theme is installed, you will be given 

the choice to view a Live Preview, immediately Activate the theme or return to the 

Theme Installer. 

On the Add Themes page, you also have the option to manually upload a theme to 

your site. To upload a theme, click the Upload Theme button at the top of the page. 



 

 

Select your theme file from your computer by clicking the Browse… button. Your 

theme file must be uploaded in .zip format. 

After clicking the Install Now button, your theme will be automatically uploaded 

to your site and installed. You are then given the option to preview the theme, 

activate the theme or return to the Themes page. 

Customizing your Site 
Using the Customizer, you can modify certain parts of your website. When you 

click on the Customize menu option you’ll be shown the various theme options 

that you can change. Depending on the theme that is currently in use, you may 

see more or less options than those displayed in the following image. 



 

 

Clicking the small arrows will open and close each of the panels, giving you access 

to each of the various options. You’ll find that some of the options in the 

Customize screen are also available via other menu options. As an example, you 

can change the Site Title and Tagline within the Site Identity panel in the 

Customizer, as well as by using the General option under the Settings menu. 



 

 

As you make your changes on the left-hand side of the Customize screen, the live 

preview on the right-hand side is automatically updated. You can also use the live 

preview window on the right-hand side of the page to navigate around your site. 

By default, the Customizer will show your homepage in the preview window. Not 

all Customizer options affect the homepage though. You’ll find that some options 

in the Customizer may also affect other parts of your site such as your blog, or 

static Pages. You can browse around your site in the live preview window to view 

these other pages, just like you would when viewing your site in a separate 

browser window. 

Until you click the Publish button, only the theme preview is updated, not the 

theme on your live site. 

By default, your changes are published immediately when you click the Publish 

button. By clicking on the small cog icon ( ) next to the Publish button, you can 

also elect to save a draft of your changes, or have them automatically published at 

a later scheduled date and time of your choosing. 



 

 

To help with testing your site across various devices, the Customizer also allows 

you to preview your site in mobile, tablet and desktop views. At the bottom of the 

Customizer panel, click one of the view icons ( ) to change your 

site preview so that you can get an idea of how it will display on a regular 

desktop, a tablet or smartphone device. 

Widgets 
Widgets are independent sections of content that can be placed into any 

widgetized area provided by your theme. Although these widgetized areas are 

commonly called ‘Sidebars’ and are quite often located in the left or right-hand 

column, they can be also located anywhere within your site and are entirely 

dependent on the current theme as to their location. Lots of themes use these 

widgetized sidebars in the footer area. 

There are numerous widgets available by default which allow you to add extra 

content to your site, such as Recent Comments, Categories or Custom Menus, just 

to name a few. New Widgets can also be installed via plugins and again, 



 

depending what the plugin is used for the extra functionality it brings to your site 

will vary. 



 

 



 

The Available Widgets section contains all the widgets you may choose from. To 

populate one of your Sidebars, drag and drop a widget to the desired location. 

Once the Widget is dragged to a Sidebar, the widget will open up to allow you to 

configure its settings. Click the Save button within the Widget to save your 

settings. 

If you want to remove a widget from a Sidebar but save its settings for future use, 

drag it into the Inactive Widgets section. If you simply want to delete the Widget 

from your Sidebar, click the Delete link within the Widget. 

The small arrow next to the Sidebar title will toggle the sidebar open and closed. 

If you drag and drop a widget onto a closed sidebar, the sidebar and widget will 

automatically open. 

Updating the Menu 
If your theme supports custom menus, you can make modifications to them from 

the Menus option. Menus can contain links to Pages, Posts, Categories, Custom 

Links or other content types. 



 

 

Adding a New Menu 
Depending on the current Theme being used, your site may make use of more 

than one navigation menu. Sometimes you might have multiple menus in your 



 

site header, other times you may even have menus located in the sidebar or footer 

of your site. 

To add a new menu, hover your cursor over the Appearance menu option in the 

left-hand navigation menu and in the fly-out menu, click the Menus link. 

Alternatively, click the Appearance menu option and then click the Menus link 

underneath. 

On the screen that’s displayed, click the create a new menu link. You’ll be 

presented with a screen similar to below. Enter a name for your new menu in the 

Menu Name input field. Click the Create Menu button to create your new menu. 

 

Editing an Existing Menu Item 
Your current list of menu items resides in the right-hand column on the menu 

screen. If there are multiple menus on your site, there will be a dropdown list 

displayed at the top of the page that enables you to select the menu that you 

would like to edit. Simply select the menu you would like to edit from the Select a 

menu to edit dropdown list and then click the Select button. The menu items for 

your selected menu will then be displayed. 



 

 

The items in this right-hand column on the Menus page will match the menu items 

that appear on your website. Clicking on the down arrow next to each menu item 

name will show an options panel for that particular menu item. In this options 

panel, there are several items that can be updated. You can show or hide extra 

fields such as Link Target, CSS Classes, Link Relationship (XFN) or Description 

using the Screen Options tab at the very top-right of the screen. 

• URL – Only displayed for Custom Links and will contain the URL to navigate 

to when that menu item is clicked 

• Navigation Label – This is the label that will display within the actual menu 

on your website 

• Title Attribute – This is the tooltip that appears when the mouse cursor 

hovers over the menu item 

• Open link in a new window/tab – (Hidden by default) You can set the menu 

item to open in the same window or tab (which is the default) or in a new 



 

window or tab. This option is made visible by ticking the Link Target option 

on the Screen Options panel 

• CSS Classes – (Hidden by default) Optional CSS Classes to add to this menu 

item. This option is made visible by ticking the CSS Classes option on the 

Screen Options panel 

• Link Relationship (XFN) – (Hidden by default) Allows for the generation of 

XFN attributes so you can show how you are related to the authors/owners of 

site to which you are linking. This option is made visible by ticking the Link 

Relationship (XFN) option on the Screen Options panel 

• Description – (Hidden by default) The description for the link. This may or 

may not appear, depending on the theme This option is made visible by 

ticking the Description option on the Screen Options panel 

Each menu item can be moved to a new location in the menu hierarchy by using 

either the links underneath the Title Attribute input field or by clicking on the title 

area of the menu item and dragging ‘n dropping the menu to new location. If you 

choose to drag ‘n drop your menu items, the cursor will turn into a four-pointed 

arrow when you’re hovering over the correct area. 

After making updates to your menu items, click the Save Menu button at the top or 

bottom of the screen. 

Adding a New Menu Item 
By default, only the Pages, Custom Links and Categories panels are shown. If 

you’d like to add Posts, Tags or Post Formats as menu items, you simply use the 

Screen Options tab at the top-right of the screen to enable these panels as well. 

To add a new Page as a menu item, tick the checkboxes in the Pages panel, next to 

each of the Pages that you’d like to add. You can select one Page at a time or 

multiple. After selecting your Pages, click the Add to Menu button. The new menu 

items will append to the bottom of the current list of menu items. The menu item 

name will default to the Page name. To change this, simply click on the down 

arrow next to the menu item name to view the options panel and then update the 

Navigation Label to your preferred name. After making your updates, click the 

Save Menu button at the top or bottom of the screen. The steps to add a Post, Post 

Format, Category or Tag as a menu item are exactly the same as adding a Page. 



 

 

To change the order that the menu options appear in, simply place your cursor 

over the title area of the menu item you’d like to move. When the cursor changes 

to a four-pointed arrow, click and drag the menu item to its new location. 

Depending on how your menu is configured within your theme, it’s even possible 

to create the multi-level hierarchy required for dropdown menus. After moving 

your menu items around, don’t forget to click the Save Menu button at the top or 

bottom of the screen to save your changes. 

Adding a Custom Link Menu Item 
Use the Custom Links panel to add a custom link to your menu, such as a link to an 

external website. Simply type in the website URL in the URL field and the menu 

name in the Link Text field. Click the Add to Menu button when done. Use the 

same steps outlined previously to adjust the order of the menu item and click the 

Save Menu button at the top or bottom of the screen to save your changes. 



 

 

Deleting a Menu Item 
To delete a menu item click on the down arrow next to the menu item name to 

view the options panel for that item and then click the Remove link. After making 

your updates, click the Save Menu button at the top or bottom of the screen. 



 

 

Managing Menu Locations 
After you create a menu, you also need to tell WordPress where to use it. This is 

where the Manage Locations tab on the Menus page comes in. 

After clicking the Manage Locations tab on the Menus page, you will be shown a 

page similar to below, with a list of the various menu locations used in your 

Theme. You may have one menu location or you may have multiple, depending 

on the Theme currently in use. Your menu location won’t necessarily be called 

‘Primary Menu’ either, as shown below. Again, that will depend entirely on your 

Theme. 

Assign an existing menu that you’ve created to the appropriate location by 

selecting it from the dropdown list. Click the Save Changes button to save your 

changes. 

Alternatively, you can choose to create a new menu and automatically assign it to 

the location by clicking the Use new menu link. 



 

 

Header 
The Header menu option will only be available if your current Theme is making 

use of this option. It allows you to choose an image (or if your theme supports it, a 

video) to display in the header area of your site. Clicking the Header menu option 

will take you to the Header Media panel in the Customizer. In the default Twenty 

Seventeen theme, the Customizer panel is called Header Media as it supports both 

images and video. In other themes it may be called Header Image if the theme 

doesn’t support video headers. 

You can select one of your previously uploaded images or you can upload a new 

image by clicking the Add new image button. If you’re using the Twenty Seventeen 

theme, the header also supports video so you can select one of your previously 

uploaded videos or you can also choose to upload a new video by clicking the 

Select Video button. If you have videos that you’ve previously uploaded to 

YouTube, you can also enter a YouTube URL in the appropriate field. To save your 

changes, click the Save & Publish button at the top of the page. Again, depending 

on the theme you’re using you may or may not have this Header option. 



 

 

Background 
The Background menu option is another theme specific menu. It allows you to 

choose a background image for your site. Clicking the Background menu option 

will take you to the Background Image panel in the Customizer. You can select one 

of your previously uploaded images or you can upload a new image by clicking 

the Select Image button. To save your changes, click the Save & Publish button at 

the top of the page. Again, depending on the theme you’re currently using you 

may or may not have this Background option. 



 

 

Editor 
The Editor menu allows you to edit the individual CSS and PHP files which make 

up your Theme. Normally once a theme is installed and configured on your site, 

there's no need to make any changes within here. Extreme care should be taken 

with this option to avoid making changes to files that will affect how your site is 

displayed. Incorrectly modifying any files within this section can cause your site 

to display incorrectly or at worst, not at all. Extra caution must be taken if you 

intend to make any changes here. 

 

It cannot be stressed enough how dangerous this option is if you know 
nothing about HTML, CSS or PHP. Modifying your theme files can 
drastically change how your site displays and depending on what gets 
changed, can even stop your site from displaying altogether. 

 

http://en.wikipedia.org/wiki/Css
http://en.wikipedia.org/wiki/Php


 

Plugins 
Plugins extend and expand the functionality of WordPress. Once a plugin is 

installed, you may activate it or deactivate it here. There are thousands of plugins 

available that provide a huge range of functionality. The easiest place to find them 

is within the official WordPress Plugin Directory. You can search and install new 

plugins by clicking on the Add New button at the top of the page or the Add New 

link in the left-hand navigation menu. 

Once a plugin has been added to your site, it needs to be ‘turned on’. To do this, 

click the Activate link to activate it. Depending on the plugin, you might also find 

that there are settings that need to be configured. 

Activated plugins will be displayed with a different coloured background within 

your list of plugins. They will also be highlighted with a blue vertical bar down 

the left side of the row. 

If any of your installed plugins have available updates, a small number will 

appear next to the Plugins menu option. The number will advise you as to how 

many plugins have updates available. A message will also be displayed just below 

the plugin name and description, advising that it has an update, along with a link 

that allows you to view the details for the new version and another link for 

updating the plugin. 

Prior to updating a plugin, it’s wise to verify that the plugin functionality hasn't 

changed significantly as to adversely affect your site. It’s also recommended to 

check that the plugin and your site still works as expected, once it has been 

updated. 

When you click the update now link just below the plugin description, the plugin 

will automatically update whilst you remain on the Plugins page. You will be 

notified when the plugin has completed updating. 

If you have plugins that have been deactivated because you’re no longer using 

them, it’s good practice to remove them from your site. You can do this by clicking 

the Delete link underneath the plugin name. 

http://wordpress.org/plugins/


 

 

Adding a New Plugin 
To add a new plugin, click on the Add New link in the left-hand navigation menu 

or the Add New button at the top of the page. 

The Add Plugins page will display a list of the current featured plugins from the 

WordPress.org Plugin Directory. You can use the links at the top of the page to 

filter the results to see Featured plugins, Popular plugins, Recommended plugins 

or a list of the plugins that you’ve marked as ‘Favorite’ within the WordPress.org 

Plugin Directory. If you click the Favorites link, you’ll need to enter in your 

WordPress.org username and then click the Get Favorites button so that it can 

retrieve your list. 

You can also click the Search Plugins input field and enter text to search for a 

specific plugin. 



 

 

To view more information about a particular plugin, click the thumbnail image, 

the plugin name or the More Details link. A pop-up window will display more 

information about the plugin such as the plugin Version, Author and the date it 

was Last Updated. You can also read the full plugin description, installation notes, 

view screenshots and read any reviews that have been left. 



 

 

After clicking the Install Now button, the plugin will be automatically downloaded 

to your site and installed. You are then given the option to activate the plugin or 

return to the plugin installer page. 

On the Add Plugins page, you also have the option to manually upload a plugin to 

your site. To upload a plugin, click the Upload Plugin button at the top of the page. 



 

 

Select your plugin file from your computer by clicking the Browse... button. Your 

plugin file must be uploaded in .zip format. 

After clicking the Install Now button, your plugin will be automatically uploaded 

to your site and installed. You are then given the option to activate the plugin or 

return to the plugins page. 



 

Users 
This screen lists all the existing users for your site. Users with roles other than 

Administrator will see fewer options when they are logged in. Depending on your 

Role, you can also add new users as well as manage their Roles. 

At the top of the screen there are links that allow you to filter the list of Users 

based on the User Roles. The number in brackets will advise how many there are 

for that particular type. 

 

When hovering your cursor over each row in the list of Users, links will appear 

beneath the user name.  

• Edit – Allows you to edit the user profile 

• Delete – Allows the User to be deleted. This link won’t be available for your 

own profile 

A User can have one of five defined roles as set by the site admin: Site 

Administrator, Editor, Author, Contributor, or Subscriber. 

• Super Admin – (Only relevant when running multiple sites from one 

WordPress installation). Someone with access to the blog network 

administration features controlling the entire network 



 

• Administrator – Somebody who has access to all the administration features 

• Editor – Somebody who can publish and manage posts and pages as well as 

manage other users' posts, etc. 

• Author – Somebody who can publish and manage their own posts 

• Contributor – Somebody who can write and manage their posts but not 

publish them 

• Subscriber – Somebody who can only manage their profile 

When WordPress is first installed, an Administrator account with all capabilities 

is automatically created. 

The avatar that is displayed in the list of Users is using what's called a Gravatar. A 

Gravatar is a Globally Recognized Avatar. Gravatars are currently used by a huge 

number of blogs, forums, chat sites and the like. Rather than having to upload an 

avatar on each and every system you sign up to, Gravatars allow you to have one 

avatar that is viewable everywhere. To create a Gravatar, simply go to 

gravatar.com and sign up. To use your Gravatar within WordPress, simply add an 

email address to your Profile that you’ve configured within the Gravatar site and 

it will automatically display. 

Adding a New User 
To add a new user, click on the Add New link in the left-hand navigation menu or 

the Add New button at the top of the page. 

http://en.wikipedia.org/wiki/Avatar_%28computing%29
http://gravatar.com/


 

 

Once the above page is displayed, simply fill in the various fields and click the Add 

New User button. 

• Username – (mandatory) Enter the username of the new user here. This will 

also be used as the Login name for the user. Once saved, the Username can’t 

be changed 

• E-mail – (mandatory) Enter a valid email address of the new user here. The 

email address must be unique for each user. If a published Post or Page is 

authored by this user and approved comments are made to that post or page, 

a notification email is sent to this email address 

• First Name - Enter the first name of the new user here 

• Last Name – Enter the last name of the new user in this text box 

• Website – You may enter the new user's website URL in this text box 

• Password – Clicking the Show password button will show you the password 

that has automatically been generated for the new user 



 

• Send User Notification – When ticked, WordPress will send your new user 

an email about their account 

• Role – Select the desired Role for this user from the dropdown list 

WordPress will automatically generate a strong password when you create a new 

user. Clicking the Show password button will display the password that was 

generated and if you want, will also allow you to change it. The password strength 

indicator, shown just below the password field, must indicate at least Medium 

before WordPress will allow you to save the new user. It goes without saying, the 

stronger the password the more secure the login so it’s advisable that the strength 

indicator shows your password as being Strong. To make a password stronger, 

use upper and lower case letters, numbers and symbols like ! " ? $ % ^ & ). 

 

Deleting a User 
To delete a user, click on the Delete link that appears beneath the user name when 

hovering your cursor over each row. The Delete link wont appear for the user that 

is currently logged in. 



 

 

Along with deleting the user you will be given the choice of what to do with all the 

content currently assigned to that User. The available choices are: 

• Delete all content – This will delete all the content which this user created 

• Attribute all content to – This will assign all the content currently linked to 

this User, to another User of your choosing. Simply select the User from the 

dropdown list 

After making your selection, click the Confirm Deletion button to remove the User. 

Editing your Profile 
To edit your profile details, simply click on your user name, when viewing the list 

of Users or click on the Edit link that appears beneath your user name when 

hovering your cursor over each row. Alternatively, click on the Your Profile link in 

the left-hand navigation. 



 

 



 

If you’re an Administrator and would like to edit someone else’s profile, click on 

their user name when viewing the list of Users or click on the Edit link that 

appears beneath their user name when hovering your cursor over each row. 

Update the appropriate fields and then click the Update Profile button to save all 

your changes. 

Personal Options 
• Visual Editor – Checking this box disables the Visual Editor when writing 

and uses the plain html editor 

• Syntax Highlighting – Checking this box disables the syntax highlighting 

when editing code in the built-in editor 

• Admin Color Scheme – Check this radio button next to the colour scheme 

desired for the administrative panels. You have the choice of eight different 

color schemes 

• Keyboard Shortcuts – Checking this box Enables keyboard shortcuts for 

comment moderation. Keyboard shortcuts are designed to allow you to 

rapidly navigate and perform actions on comments 

• Toolbar – Checking this box will display the Admin Bar at the very top of 

your website (only for the person who is currently logged in) 

Name 
• Username – You cannot edit your Username because it is used as your 

Username during the login process. Even an Administrator cannot change 

your Username. Usually, no one else ever needs to see your Username 

• First name – Enter your first name in this text box 

• Last name – Enter your last name in this text box 

• Nickname – (mandatory) The nickname is a requirement for every user. It 

may be the same as your Username or it can be different. If you don’t supply 

a Nickname, then the Username will be placed in this field 

• Display name publicly as – Select how your name is cited on your blog, from 

the dropdown list. You can choose from several choices: Nickname, 

Username, First Name, Last Name, ‘First Last’, or ‘Last First’. If you prefer 

‘Last First’, insert a comma after your last name in the Last Name text field 



 

and choose the last option from the dropdown list. For security reasons, it’s a 

good idea to keep this different from your Username 

Contact Info 
• E-mail – (mandatory) All users are required to list an email address in their 

respective Profiles. The email address must be unique for each user. Your 

blog will use this address to notify you of new comments to your posts and 

for other administrative purposes. Only other registered users of your blog 

will have access to this email address. It is never sent anywhere 

• Website – Enter your website address 

About Yourself 
• Biographical Info – Enter a short description or profile of yourself here. 

Depending on your theme, this optional information may be displayed when 

creating new Posts 

• Profile Picture – The avatar that is displayed is called a Gravatar. A Gravatar 

is a Globally Recognized Avatar. To create a Gravatar, simply go to 

gravatar.com and sign up. To use your Gravatar within WordPress, simply 

add an email address to your Profile that you’ve configured within the 

Gravatar site and it will automatically display 

Account Management 
• New Password – Click the Generate Password button to generate a new 

Strong password. A password strength indicator will be shown just below the 

password field 

• Sessions – If you’ve left your account logged in at a public computer or 

you’ve lost your phone, you can click the Log Out Everywhere Else button to 

log you out of everywhere except for your current browser 

 

http://en.gravatar.com/


 

Tools 
The Tools menu provides some handy administration tools. Most of the time 

though, they're used when setting up or configuring your WordPress site and so 

as such, they won’t be covered here in great detail. 

Available Tools 
The Available Tools menu option gives you access to the Categories and Tags 

Converter. The Categories and Tags Converter is a tool for converting Categories to 

Tags or vice versa. Before it can be used it must be installed via the Import menu 

option. 

Import 
The Import option provides you with various tools for importing content from 

other blogging systems. You can import content from Blogger, LiveJournal, 

Moveable Type, TypePad and Tumblr. You can also import content from Blogrolls 

that use the OPML Format, posts from an RSS feed or content from other 

WordPress sites. To import content from another WordPress site you first need to 

install the WordPress Importer plugin. To import content from another type of 

site other than WordPress, you’ll be prompted to install the relevant Importer 

plugin after selecting the type of site that you’d like to import your content from. 

Export 
The Export option is used to export your data in XML format, from your 

WordPress site. The export format is called WordPress eXtended RSS or WXR and 

will contain your posts, pages, comments, custom fields, terms, navigation menus 

and custom posts. Once you’ve saved the download file, you can use the Import 

function on another WordPress site to import the content from this site. 

http://en.wikipedia.org/wiki/OPML
http://wordpress.org/extend/plugins/wordpress-importer/


 

Settings 
The various Settings screens are used to configure your WordPress site. Normally, 

once your WordPress site is set up there’s no reason to change any of these 

settings. These Settings options will only be touched upon very briefly. You can 

find out lots more information in regards to configuring your site within the 

WordPress Codex. 

General 
The General settings configure your basic site preferences such as the Site Title 

and Tag Line, the WordPress Address and Site Address, the administrators email 

address and the date and time format, among other things. 

The WordPress Address (URL) is the location of your main WordPress core files. 

The Site Address (URL) is the address you want to use for your site homepage. 

Usually these two URL’s are the same but they can be different if, for example, 

you have your WordPress files stored in a subdirectory. 

When you install WordPress, you get the option to select the language that you’d 

like to use within the Dashboard. After installation, if you’d like to change the 

language, you can select this using the Site Language dropdown at the bottom of 

the page. 

http://codex.wordpress.org/Main_Page


 

 



 

Writing 
The Writing settings configure various options with regards to your site content. 

Settings include defining the Default Post Category, Default Post Format (if 

supported by your Theme) and if the Link Manager plugin is installed, the Default 

Link Category. 

 

Reading 
The Reading settings configure how your site is viewed. You can define whether 

your front page displays a static Page or your blog Posts, how many blog posts are 

displayed by default as well as Syndication/RSS options. If you configure your site 

to display a static front page, you can set which page to display and also which 

page will show your blog posts. 



 

The Search Engine Visibility setting enables you to block your site from search 

engines or allow it to be visible. 

 

Discussion 
The Discussion settings define how your readers interact with your site and how 

your site interacts with other blogs. You can configure Pingbacks and Trackbacks, 

whether readers can post Comments or not and if so, how those Comments are 

moderated and displayed on your site. 

This screen also lets you configure whether the Post Author should be emailed 

whenever someone posts a comment on your site. If you are receiving emails 

whenever someone posts a comment, simply uncheck the box next to Anyone 

posts a comment within the E-mail me whenever section on this screen and then 

save your changes. 

If you would like to be notified whenever a comment is held for moderation, it 

can be configured on this screen as well within the E-mail me whenever section. 

http://codex.wordpress.org/Introduction_to_Blogging#Pingbacks
http://codex.wordpress.org/Introduction_to_Blogging#Trackbacks


 

The email notification is sent to the email address listed on the Settings > General 

page. 



 

 



 

Media 
The Media settings define the default image sizes that are created when an image 

is uploaded. 

You can also configure whether your uploaded media files are stored in folders 

based on the year and the month of the upload. 

 

Permalinks 
The Permalink settings enable you to configure the URL format that is displayed in 

the web browser when someone browses your site. WordPress will default your 

Permalinks to the Day and name format however you can change this so that the 

URL is more user friendly. This also helps considerably with Search Engine 

Optimisation (SEO). To change the way your site URL is displayed simply select 

one of the radio button options within the Common Settings section on this screen. 

Next to each option is an example of how the URL would be displayed. 



 

 



 

Keeping your Site Updated 
From time to time, themes, plugins & WordPress will require updating. Updates 

typically happen when developers release security patches or add extra 

functionality. 

It’s good practice to keep your themes, plugins & WordPress version updated to 

the latest versions. The top two reasons for sites being hacked are insecure 

passwords & outdated (vulnerable) software. 

In an effort to promote better security and to streamline the update experience, 

WordPress will automatically update itself, if it’s able to, whenever a minor 

version is released (e.g. v4.8.2, v4.9.1). These minor releases are usually for 

maintenance and security purposes or translation file updates. Only core 

WordPress files will be auto-updated. Your themes or plugins won’t be 

automatically updated. 

Once your site is auto-updated your site administrator will be notified by email. If 

your WordPress installation can’t update itself automatically for one reason or 

another, your site administrator will be notified of this as well. 

To update your WordPress version manually or to update your themes and 

plugins, hover your cursor over the Dashboard menu option in the left-hand 

navigation menu and in the fly-out menu, click the Updates link. Alternatively, 

click the Dashboard menu option and then click the Updates link underneath. 

The Updates page is divided into three sections. If your version of WordPress 

requires updating, this will be displayed at the top of the page. Below that, you’ll 

be notified of any plugin updates and below that again, theme updates. 

Updating your WordPress version is as simple as clicking the Update Now button. 

WordPress will download the necessary files, perform a validation of those files 

and then automatically update your site. 

Before updating your site, it’s always wise to perform a backup first, just in case 

something unfortunate happens during or after the installation. 



 

 

If there are any plugins that can be updated, these will be listed in the Plugins 

section on the page. To update your plugins, tick the boxes next to each of the 

plugins you wish to update and then click the Update Plugins button. The new 

plugin files will be downloaded and automatically installed. 

If there are any themes that can be updated, these will be listed in the Themes 

section on the page. To update your themes, tick the boxes next to each of the 

themes you wish to update and then click the Update Themes button. The new 

theme files will be downloaded and automatically installed. 



 

After your site has been updated, no matter whether it’s been done automatically, 

manually or just themes and plugins, it’s a good idea to give your site a quick test 

to make sure it’s functioning as expected. This will ensure that the new themes, 

plugins or even WordPress itself hasn’t introduced new functionality that 

adversely affects your site or changes how your site operates. 

Where To From Here? 
If you’re looking for more resources to further your WordPress knowledge the 

first place to check out is the WordPress.org website. There you’ll find technical 

support and new resources like plugins which are a fantastic way to add extra 

functionality to your site without having to modify your theme files. The Plugin 

Directory has over 53,000 different plugins that are available to download, for 

free. Furthermore, if you want to change how your site looks, have a look in the 

WordPress Themes Directory which is also there on the WordPress site. 

If you find you need more information on a particular topic, have a search 

through the WordPress Codex which goes into greater detail about how 

WordPress works. Not only will you find information about updating your site 

content but there is all sorts of other useful information that will help you with 

installing WordPress, troubleshooting, using plugins & themes and also theme 

development, for the more technically minded. 

Once your website is humming along nicely, you might want to think about 

getting involved in the awesome WordPress community. One of the easiest ways 

to get involved is simply by helping others within the WordPress Support Forums. 

There is always someone there who’s newer to the learning curve than you, and 

learning is so much improved while you’re teaching others! There are topics there 

for all ability levels, from installation issues, theme and template issues, and 

general troubleshooting all the way through to more advanced areas of theme 

and plugin development. 

It’s a great benefit not just for yourself, but for others as well in getting more 

involved in the WordPress community. This could be through core commits, UI 

design, testing beta releases or even just helping people on the WordPress forums. 

Or, how about getting along to Meetups where users and developers alike get 

together and learn from and teach each other, show off the projects they’re 

http://wordpress.org/
http://wordpress.org/plugins/
http://wordpress.org/plugins/
http://wordpress.org/themes/
http://codex.wordpress.org/Main_Page
http://wordpress.org/support/


 

working on and meet others to collaborate with. The more we work together to 

make WordPress great, the more robust the platform becomes. Everyone wins! 

Last but not least, don’t forget to keep in touch with us on the web; 

http://easywpguide.com 

  

http://easywpguide.com/


 

 

 

 



 

WELCOME.SMLS.ORG INFO 
 Users: 

PERSON ROLE USER NAME PASSWORD 
Julie Nehr Editor St. Matthew's  RyZXLq!8kBGR!p)9Q^cc&F^Y 
Amber Terry Editor First Steps vlfN&HSz^3jHJOudMjd$kUgq 
Eric Ziel Administrator eziel ez    (Change ASAP) 
Eric Paulsen Administrator epaulsen  
Pastor Schmidt Editor Dschmidt n^9b0bzNi&ECb8!0K667mOYX 

 

User Notes: 

Eric Paulsen is set up as an Administrator because he is the site administrator. 

Eric Ziel is set up as an Administrator so that he can access Easy Appointments 

and set his own schedule for school tours. 

 

Editors can edit pages and posts for themselves and others. If you need more 

access, please contact Eric Paulsen, and he can adjust the ROLE settings. 



 

STYLING GUIDELINES 

Hex Colors 
 Red: #E6503D – rgb (230,80,61) 

 Dark Gray: #7A6E66 – rgb (122,110,102) 

 Light Gray: #BFBDBA – rgb (191,189,186) 

Image Sizes: 

 Custom Header Image 
Width: Flexible (recommended width 1200px) 
Height : Flexible (recommended height 400px) 

 Slider – Found only on the home page 
Width: 1200px 
Height: 514px 

 Featured Content 
Width: 350px 
Height: 197px 

 Featured – Used for Bible Studies, Sermons and News posts. 
Width: 860px 
Height: 484px 

 Square 
Width: 200px 
Height: 200px 

 

  



 

UPDATING WEBSITE CONTENT 
 

Home Page Promotional 
Headline 
 

To change the promotional headline, go to 

the WordPress Dashboard. From there, select 

Appearance -> Customize -> Theme Options -

> Promotional Headline Options. See image 

on the right. Change the necessary text. 

When you finish making changes, be sure to 

click the blue Publish button on the top. 

When it has been saved, the button will read 

“Published” as in the picture to the right. 

 

Menus 
The main menu on the St. Matthew site is 

called the Primary Menu. You can change 

what appears in the menu and the order it 

appears in.  

  



 

Lunch Menu, Forms & other PDF files 
To update the lunch menu – as an example: 

 Login to the site. 

 Add the new .pdf menu to the Media Library 

 Navigate to http://welcome.smls.org/school/parent-information/school-

hot-lunch-milk/ 

 Click on “Edit Page” 

 Choose the Text tab in the page editing area. 

 Find the bracketed code [pdf-embedder url="page_url.pdf"] Delete it. 

Leave your cursor there. 

 Click on Add Media. 

 Select the new .pdf menu and click Insert into Page (blue button on 

bottom right) 

 Update the page using the button on the right side. 

 

Add Posts 
Use +Posts for news articles, Bible studies and sermons. 

Set featured image (right side of Add Post page). The featured image will appear 

large at the top of the post/article. The same image will also show up as a small 

image on the Content Views pages (Church News, School News, News, Bible 

Studies, Sermons) The featured image should be Width: 860px, Height: 484px. 

(See the Site Plugins section for more information on Content Views.) 

 

  

http://welcome.smls.org/school/parent-information/school-hot-lunch-milk/
http://welcome.smls.org/school/parent-information/school-hot-lunch-milk/


 

Categories on St. Matthew’s Site 
Remember to select the proper categories for each post. This is a listing of 

categories that have been set up prior to launch. You can add new categories as 

needed. (See page 71.) 

 

    Bible Studies 
    Church News 
        Sermons  
            Baptism 
            comfort 
            Commitment 
            Forgiveness 
            Grace 
            Praise 
            Service 
            Suffering 
            Who is Jesus? 
    First Steps News 
    School News 
    Uncategorized 
    Youth 

 

Bible Studies  

Titles should be formatted as Day: Topic. 
 
In the article part of the post, provide details about the Bible study. 
Keep in mind these posts are primarily for new people coming to 
check out your classes. These posts can be linked to from things 
like Facebook events, Craigslist and other community calendars.  
 
Be sure to update this part of the site when Bible study topics 
change. 



 

Adding Relevant News  
The news section on the website is primarily a way for St. Matthew’s and First 

Steps to communicate important information to prospective members. It is not a 

tool to communicate internal messages. Here is a list of guidelines to follow to 

help you determine if an item should be posted in the news section. 

Examples of what NOT to include: 

 Past events should be posted rarely. Primarily this would be if you are 

posting a link or image showing a news clip that addressed the event. Or, as 

an example, if it were a fundraiser for the community or for scholarships 

and you wanted to provide an update on what your total was. 

 Recital information 

 Board meeting minutes or agenda 

 Upcoming sporting game times 

 PDF of newsletters/weekly emails  

Examples of news items.  

 Visitor-focused – does this show a them what you do well? Make text 

inviting and welcoming. 

 Newsworthy – before posting, asking if a visitor would care about it and 

find this valuable.  

 Highlight events that focus on ministry – welcoming visitors to participate 

and make it easy for them to attend with details the details. 

 Open houses, tours and the dedication/opening of the new building  

 Open-enrollment and pre-registration info 

 New programs introduced 

 Expanding services/hours and staff (called workers, etc.) 

 New Bible studies. List all details News clip of St. Matthew’s PR 

 Outreach events –Chili fest or carnivals 

 Weekly sermons and bulletins 



 

Change the NEWS (post) Excerpt Length and 
Read More Text 

1. Go to “Appearance => Customize => Theme Options => Excerpt Options” 
2. Type in the Excerpt Length as in, the number of words, and Read More Text 
3. Finally, click on “Save & Publish” 

Embed FORWARD Videos into Posts / Pages  

For externally hosted videos (for example a YouTube or Vimeo video), you can 
directly paste the link of your video page into the content editor. You do not 
necessarily have to paste the embed code in the content. WordPress will 
automatically embed the video from the link. 

Grow Page (under Church) 
The bible studies are pulled in using a plugin called Content Views. Here is the 
information on how to make changes with the plugin: 
 
https://docs.contentviewspro.com/?utm_source=client&utm_medium=settings_pag
e&utm_campaign=gopro 
  

https://docs.contentviewspro.com/?utm_source=client&utm_medium=settings_page&utm_campaign=gopro
https://docs.contentviewspro.com/?utm_source=client&utm_medium=settings_page&utm_campaign=gopro


 

CATCH RESPONSIVE PRO (THEME) 

How to add Featured Image in Post/Page? 

1. Open the editor of the post/page where you want to display image, and locate the 
Featured Image module in the bottom right corner under Page Attributes. Click on 
Set Featured Image. (Width: 860px. Height: 484px.) 

2. Then you can either upload the image from your computer or select the existing 
image from your media library and click on Set Featured Image.  

 

3. For more detail, https://catchthemes.com/blog/videos-blog/video-series-adding-
featured-image-wordpress-postpage/ 

Header Image 

Custom Header Image is different from site logo. It’s a large global image in the header to 
obtain a much more personalized look and feel. To add header image, you need to go to 
“Appearance => Customize => Header Image”. Here, you can add/change/hide Header 
Image, select option to Enable Featured Header Image on, Position, Size and add in links 
and alt tag as per your website need. 



 

Options to Enable Header Featured Image 

When you are in “Appearance => Customize =>; Header Image”, you will see option 
“Enable Featured Header Image on”. There are 7 options, which gives you flexibility to 
add Header Image as per your website need. 

Option 1: Homepage/Frontpage 
This option will show header image in Homepage/Frontpage only. 

Option 2: Excluding Homepage 
This option will show header image throughout the site, excluding Homepage. 

Option 3: Excluding Homepage, Page/Post Featured Image 
This option will show header image throughout the site excluding Homepage. But in 
Page/Post, your header image will be replaced by Featured Image. 

Option 4: Entire Site 
This option will show header image throughout the site. 

Option 5: Entire Site, Page/Post Featured Image 
This option will show header image throughout the site. But in Page/Post, your header 
image will be replaced by Featured Image. 

Option 6: Page and Post 
This option will show Header Image in Page and Post only. But in Page/Post, your header 
image will be replaced by Featured Image. 

Option 7: Disable 
This option will disable Header Image completely. 

Change and Enable Custom Header Image 

1. Go to “Appearance => Customize => Header Image” 
2. Now, select enable options in “Enable Featured Header Image on” 
3. Click on “Add New Image” to add new header image 
4. Then you can either upload the image from your computer or select the existing 

image from your media library 
5. Click on “Select and Crop” and you can either crop image or skip cropping 
6. Finally, click on “Save & Publish” 



 

FEATURED CONTENT 

Featured Image Slider ( on the homepage) 

For Featured Slider Options, go to 
“Appearance => Customize => Featured Slider 
Options”. 

Featured Image Slider is created to highlight 
independent images in the slider. This slider 
gives you full control to upload your own 
independent image, with title (optional), 
content (optional), optional link and target. 
Just use the following simple steps to add in 
the Featured Image Slider. 
Click here to watch our Video Screencast to 
add Featured Image Slider. 

How to enable Featured Image Slider? 

1. Make sure featured slider is enabled 
2. Under “Select Slider Type”, Select Slider 

Type as “Featured Image Slider” 
3. Then, upload Image, add in link, title, 

content as per your need 
4. Finally, click on “Save & Publish” 

Note: 
When you select page, make sure your page 
have Featured Image. Click here to watch our 
Video Screencast to add Featured Image. 

How to change Transition Effect, Transition 
Delay and Transition Length on Slider? 

1. Go to “Appearance => Customize => 
Featured Slider => Featured Slider 
Options” from your WordPress 
Dashboard 

2. To change Transition Effect, select 
option under “Transition Effect” 

3. To change Transition Delay, change 
number of second(s) under “Transition 
Delay” as per your need 

https://www.youtube.com/watch?v=Su0FigByCbY
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-slider-content
https://catchthemes.com/blog/videos-blog/video-series-adding-featured-image-wordpress-postpage/


 

4. To change Transition Length, change number of second(s) under “Transition 
Length” as per your need 

5. Finally, click on “Save & Publish” 

Image Loader 

1. Go to “Appearance => Customize => Featured Slider => Featured Slider Options” 
from your WordPress Dashboard 

2. Under “Image Loader”, select “True, False or Wait” as per your need 
3. Finally, click on “Save & Publish” 

Note: 
True: Fixes the height overlap issue. Slideshow will start as soon as two sliders are 
available. Slide may display in random, as image is fetch. 
Wait: Fixes the height overlap issue. Slideshow will start only after all images are 
available. 

How to change number of slides and select Featured Page? 

1. Make sure featured slider is enabled 
2. Go to “Appearance => Customize => Featured Slider => Featured Slider Options” 

from your WordPress Dashboard 
3. Under “No of Slider”, select the number slides as per your need 
4. Then, under “Featured Page #1, Featured Page #2, Featured Page #3 and Featured 

Page #4”, select desired page to show in slider 
5. Finally, click on “Save & Publish” 

Featured Content 

Catch Responsive Pro supports 5 featured content types: Featured Widget Content, 
Featured Post Content, Featured Page Content, Featured Category Content and Featured 
Image Content. For Featured Content Options, go to “Appearance => Customize => 
Featured Content => Featured Content Options”. 

How to enable Featured Content? 

1. Go to “Appearance => Customize => Featured Content => Featured Content 
Options” from your WordPress Dashboard 

2. To enable featured content, select “Homepage/Frontpage or Entire Site” option 
under “Enable Featured Content on” 

3. Under “Select Content Type”, you need to select “Featured Widget Content, 
Featured Post Content, Featured Page Content, Featured Category Content or 
Featured Image Content” as per your need 

4. Finally, click on “Save & Publish” 

https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-slider-content


 

Featured Post Content: 

Featured Post Content is created to highlight your Post in the featured content. So, first 
you need to create a Post and then add Featured Image to the Post. 

How to enable Featured Post Content?# 

1. Make sure featured content is enabled 
2. Under “Select Content Type”, you need to select “Featured Post Content” 
3. Then, add in Post ID in Featured Post 1, Featured Post 2 and so on 
4. Finally, click on “Save & Publish” 

Note: When you select post, make sure your Post has a Featured Image. Click here to 
watch our Video Screencast to add Featured Image. 

Featured Page Content: 

Featured page content is created to highlight your Page in the featured content. So, first 
you need to create a Page and then add Featured Image to the Page. 

How to enable Featured Page Content? 

1. Make sure featured content is enabled 
2. Under “Select Content Type”, you need to select “Featured Page Content” 
3. Then, select Page in Featured Page 1, Featured Page 2 and so on 
4. Finally, click on “Save & Publish” 

Note: When you select page, make sure your Page have Featured Image. Click here to 
watch our Video Screencast to add Featured Image. 

Featured Category Content 

Featured category content is created to highlight your posts from specific categories in 
the featured content. So, first you need to create a Post, add Featured Image to the post 
and assign posts to specific category. 

How to enable Featured Category Content? 

1. Make sure featured content is enabled 
2. Under “Select Content Type”, you need to select “Featured Category Content” 
3. Then, select Categories 
4. Finally, click on “Save & Publish” 

https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-post-content
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/blog/videos-blog/video-series-adding-featured-image-wordpress-postpage/
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/blog/videos-blog/video-series-adding-featured-image-wordpress-postpage/
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content


 

Note: When you select categories, make sure your Posts in those categories have 
Featured Image Click here to watch our Video Screencast to add Featured Image. 

Featured Image Content: 

Featured Image Content is created to highlight independent images in the featured 
content. This option gives you full control to upload your own independent image, with 
title (optional), content (optional), optional link and target. Just use the following simple 
steps to add in the Featured Image Content. 

How to enable Featured Image Content? 

1. Make sure featured content is enabled 
2. Under “Select Content Type”, you need to select “Featured Image Content” 
3. Then, upload Image, add in link, title, content as per your need 
4. Finally, click on “Save & Publish” 

Featured Widget Content: 

Featured Widget Content is different from above Featured Contents. It is created to give 
you more control in this placeholder called “Featured Widget Content”. You can add 
widgets like as advertisement, recent posts, text, images and so on per your need in this 
Featured Widget content. 

How to enable Featured Widget Content and add widgets to Featured Widget 
Content? 

1. Make sure featured content is enabled 
2. Under “Select Content Type”, you need to select “Featured Widget Content” 
3. Click on “Save & Publish” 
4. Then go to “Appearance => Widget => Featured Widget Content”, add desired 

widgets in Featured Widget Content by dragging the widget 
5. Make the required changes and “Save” the widget 

How to change Featured Content Layout? 

1. Catch Responsive Pro currently supports two layouts: 3 columns and 4 columns 
2. Make sure featured content is enabled 
3. Go to “Appearance => Customize => Featured Content => Featured Content 

Options” from your WordPress Dashboard 
4. Under “Select Featured Content Layout”, you can select your desired layout from 

“3 columns” or “4 columns” 
5. Finally, click on “Save & Publish” 

https://catchthemes.com/blog/videos-blog/video-series-adding-featured-image-wordpress-postpage/
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content


 

How to Move Featured Content above Footer? 

1. Make sure featured content is enabled 
2. Go to “Appearance => Customize => Featured Content => Featured Content 

Options” from your WordPress Dashboard 
3. Check option, “Check to Move above Footer” 
4. Finally, click on “Save & Publish” 

How to change Headline and Subheadline? 

1. Make sure featured content is enabled 
2. Go to “Appearance => Customize => Featured Content => Featured Content 

Options” from your WordPress Dashboard 
3. Under “Headline for Featured Content”, you can change the text as needed or 

Leave field empty if you want to remove Headline 
4. Under “Sub-headline for Featured Content”, you can change the text as needed or 

Leave field empty if you want to remove Sub-headline 
5. Finally, click on “Save & Publish” 

Note: Make sure the number of sliders are greater than the Featured Content Layout 
(greater than 3 for 3 columns and greater than 4 for 4 columns) for Sliding Effect to be 
enabled even after checking “Check to Enable Sliding Effect” option. 

How to change number of Featured Content? 

1. Make sure featured content is enabled 
2. Go to “Appearance => Customize => Featured Content => Featured Content 

Options” from your WordPress Dashboard 
3. Under “No of Featured Content” set number of Featured Content as required (You 

need to save and refresh the page after changing number of Featured Content) 
4. Finally, click on “Save & Publish” 

Note: For best results, it is recommended to set number of featured content to be 
multiple of Featured Content Layout (E.g. for 3 columns layout, 3, 6, 9 etc. will yield best 
results). 

How to Display/Hide Content? 

1. Make sure featured content is enabled 
2. Go to “Appearance => Customize => Featured Content => Featured Content 

Options” from your WordPress Dashboard 
3. Under Display Content, you can select “Show Excerpt, Show Full Content or Hide 

Content” to display excerpt as content, whole content as content or not display 
content respectively, as per you need 

4. Finally, click on “Save & Publish” 

https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content
https://catchthemes.com/theme-instructions/catch-responsive-pro/#enable-featured-content


 

PLUGINS  

Content Views 
This is the plugin that curates the news and other posts like Bible studies and sermons 
into the pages. You can up a content view to be a list or a grid. Most of St. Matthew’s 
content views are set as grids. 
https://wordpress.org/plugins/content-views-query-and-display-post-page/ 
 
Currently set to no limit of posts. You can set that to any number to only show the most 
recent items. Older items would be available to find by search. 
Content Views documentation: https://docs.contentviewspro.com/ 
 

Contact Form 7 
https://contactform7.com/ 

Easy Appointments 
Documentation: https://easy-appointments.net/ 

Easy Appointments is used on this page: http://welcome.smls.org/school/set-

appointment-eric-ziel/ to set appointments with Eric Ziel. 

 

Login to site dashboard. Click on Easy Appointments. Select Settings, and then 

Connections icon at the top. Hover over St. Matthew’s School Tour. Select Edit on 

the right side of the screen. Then, you can change Eric’s availability for school 

tours. Save when done. 

 

https://wordpress.org/plugins/content-views-query-and-display-post-page/
https://docs.contentviewspro.com/
https://contactform7.com/
https://easy-appointments.net/
http://welcome.smls.org/school/set-appointment-eric-ziel/
http://welcome.smls.org/school/set-appointment-eric-ziel/


 

You can manually add an appointment. Login to site dashboard. Click on Easy 

Appointments. Select Appointments. Then, Click on the blue text +Add New 

Appointment. 

 

 

Flamingo 
This plugin saves the messages sent from within the Contact Form 7 forms. 

Google Maps Widget Plugin 
Google Maps API Key: AIzaSyBkff6wKci8eoMuqWtgNrh0wRu_4CMg_rM 
Terms of Service: https://developers.google.com/maps/terms 

PDF Embedder Premium 
This is how you are able to view the PDF files without having to download them. 

If you want to print the files, you will still need to download them first. You 

cannot print a .pdf file without downloading it first to your computer. 

Simple Calendar 
Used to import St. Matthew’s google calendar events into the website. The 

calendars on the site are: 

 Church 

 First Steps  

 School 

 WI Ave Gym Usage 

https://developers.google.com/maps/terms


 

Yoast SEO Premium 
In order to make edits to the keywords or snippet for a page, you can see that 

there are fields on the Edit Page screen underneath the Visual / Text Editor. 

Follow the directions to make your pages optimized for search engines. 

 



 

Two more tools of Yoast SEO Premium: 

 

From the dashboard, select Plugins -> Installed Plugins. Then scroll down to the 

bottom. When you see Yoast SEO Premium, click on the Settings link below the 

Plugin Title. You will see something similar to this on the screen: 

 

Click on the ‘orphaned’ posts. It will take you to a list of posts that have no links 

going to the posts. That means that you may have missed selecting a category for 

the post (which means that it won’t show up in the news, sermons or bible study 

sections). 

 

The other great feature of this plugin is located on the right side of any page or 

post that you are editing. This little window gives you suggestions for pages that 

you may want to link within the St. Matthew’s website. 

 

  



 

WebEmailProtector Plugin 
To see if emails are protected, go to WordPress dashboard -> Settings -> 
WebEmailProtector 
 
Email addresses in green are protected. Email addresses in red are not. To add a 
new email address, click the ADD ANOTHER button at the bottom under the table. 
Enter the new email address in the secured email address column. Enter the 
name in the displayed text column.  

 
 
 
You can register the email (which you have to do for this to work) by clicking REGISTER 
to the right of the name. Or you can enter the email here: 
https://www.webemailprotector.com/cgi-bin/reg.py?cms=wp 
   
  

https://www.webemailprotector.com/cgi-bin/reg.py?cms=wp


 

If you go to the webpage, you need to enter the URL as www.welcome.smls.org and the 
CMS/language instructions are set to WordPress. Also be sure to check the box for FREE 
usage.  
 

 
 
Once the email has been registered, you can click VALIDATE next to the email in 
WordPress dashboard -> Settings -> WebEmailProtector. If the email has been properly 
registered, it should change to green text. 
 

 

WP Sitemap Page 
Creates a sitemap for the full website. This is where you see pages organized by 

their parent pages. 

 

 

 

 

http://www.welcome.smls.org/

